# TABLE OF CONTENTS

1. INTRODUCTION .................................................................................................................. 5

2. INSTALLATION ..................................................................................................................... 7
   2.1 Minimum Hardware and Software Requirements ............................................................... 7
   2.2 Installation from CD-ROM ................................................................................................. 7
   2.3 Following the Installation Steps ......................................................................................... 8
   2.4 Welcome and Software License Agreement ........................................................................ 8
   2.5 Networking Options ........................................................................................................... 8
   2.6 Choose Destination Location ............................................................................................ 9
   2.7 Selecting the Program Folder ............................................................................................ 10
   2.8 Select Environment Options ............................................................................................. 10
   2.9 Final Check and Copying the Files .................................................................................... 11
   2.10 Completing the Setup ....................................................................................................... 11
   2.11 Uninstalling Edison .......................................................................................................... 12
   2.12 Maintaining or Repairing an Installation ......................................................................... 12
   2.13 Network Installation ........................................................................................................ 13
   2.14 Copy Protection ............................................................................................................... 14
   2.15 Copy Protection by Hardware (dongle) ............................................................................ 16

3. USING THE EDITOR ................................................................................................................. 17
   3.1 The Screen Layout .............................................................................................................. 17
   3.2 Parts .................................................................................................................................. 17
   3.3 Using the 3D Editor ............................................................................................................ 18
   3.4 Using the Plug in Breadboard ........................................................................................... 19
   3.5 Creating an Electro-Mechanical Experiment ...................................................................... 20
   3.6 Selecting Between Component Groups ............................................................................ 20
   3.7 Adding, Deleting and Modifying Wires ............................................................................ 20
   3.8 Selecting, Moving and Deleting Parts in the Working Area ............................................... 21
   3.9 The Edison Control Panel ................................................................................................ 22
   3.10 Drawing Diagrams ........................................................................................................... 22
   3.11 Deriving Formulas ........................................................................................................... 23

4. GETTING STARTED .................................................................................................................. 24
   4.1 Building and Analyzing Circuits ......................................................................................... 24
   4.2 Transient Mode .................................................................................................................. 25
   4.3 AC analysis ......................................................................................................................... 26
   4.4 AC characteristic ................................................................................................................ 26
   4.5 Building a Circuit Using a Breadboard .............................................................................. 27
   4.6 Building a PIC Circuit ........................................................................................................ 28
   4.7 Building an Electro-Mechanical Circuit ............................................................................ 32

5. THE PARTS .............................................................................................................................. 35
   5.1 Connector ........................................................................................................................... 35
   5.2 Simple Switches ................................................................................................................ 35
   5.3 Push Button ....................................................................................................................... 35
   5.4 Alternative Switches ......................................................................................................... 35
   5.5 Relay ................................................................................................................................. 35
   5.6 Batteries ............................................................................................................................ 36
   5.7 Power Supply ..................................................................................................................... 36
   5.8 Resistors ............................................................................................................................. 36
   5.9 Potentiometer (Variable Resistor) ..................................................................................... 37
   5.10 Electric Bulbs ................................................................................................................... 37
   5.11 Electric Motor .................................................................................................................. 37
   5.12 Capacitor .......................................................................................................................... 37
5.13 Coil .................................................................................................................................. 38
5.14 Meters ............................................................................................................................. 38
5.15 Using the Increasing/Decreasing Buttons ................................................................... 38
5.16 Signal Generator ............................................................................................................ 38
5.17 Oscilloscope ................................................................................................................... 39
5.18 Signal Analyzer .............................................................................................................. 39
5.19 Speaker ........................................................................................................................... 40
5.20 Semiconductor Components ........................................................................................ 40
5.21 Fuse ................................................................................................................................ 40
5.22 Gear .................................................................................................................................. 40
5.23 Pulley .............................................................................................................................. 41
5.24 Worm Gear ..................................................................................................................... 41
5.25 Rack-Pin .......................................................................................................................... 41
5.26 Axle .................................................................................................................................. 41

6. THE COMMANDS .............................................................................................................. 42
6.1 File .................................................................................................................................. 42
6.2 Edit .................................................................................................................................. 43
6.3 Options ........................................................................................................................... 45
6.4 Experiments ................................................................................................................... 48
6.5 Problems ......................................................................................................................... 49
6.6 Simulation ....................................................................................................................... 52
6.7 Help .................................................................................................................................. 52

7. THE SCHEMATIC ANALYZER ........................................................................................ 53
7.1 What is the Schematic Analyzer? ................................................................................ 53
7.2 Experimenting with Example Circuits ........................................................................ 53
7.3 Schematic Editing Using the Mouse ............................................................................ 53
7.4 Measurement Units ....................................................................................................... 54
7.5 The Basic Screen Format ............................................................................................. 55
7.6 Placing the Circuit Components ................................................................................. 56
7.7 Exercises ......................................................................................................................... 57
7.7.1 Editing a Circuit Schematic ................................................................................... 57
7.7.2 Running an Analysis ............................................................................................... 60
7.7.3 Analyzing a Digital Circuit .................................................................................... 63
7.7.4 Testing your circuit in interactive mode ............................................................. 66
7.7.5 Microcontroller circuits ........................................................................................ 67
Edison provides a unique new environment for learning electricity and electronics. Teachers, students and electronics enthusiasts can use digitally scanned photorealistic components, a solderless breadboard, virtual instruments, sound and animation to create, test, and safely repair lifelike 3D circuits and simultaneously see the corresponding circuit schematic. Edison also comes with over 100 experiments and problems that teachers and students can use immediately.

Select lifelike batteries, resistors, diodes, LEDs, transistors, logic gates, flip-flops, and even integrated circuits—all easily available on the shelves of your multimedia lab. Pick and drag components onto your worktable or plug them into the realistic virtual breadboard, where you can even see the hidden internal connections. Wire the parts together with the mouse and your circuit begins working immediately so you can test and troubleshoot it with virtual instruments. In addition, Edison automatically prepares a standard schematic diagram and displays it simultaneously.

Once you have become familiar with schematic diagrams, you can use Edison’s schematic editor and circuit analyzer, compatible with the more advanced TINA circuit analysis program. In addition to its virtual instruments, which show results in small, realistic instrument displays, Edison presents data in a sophisticated analysis results window of desktop publishing quality. Using the results window, you can present circuit analyzes with full control over axes, line style, color and fonts. You can even print these diagrams directly from Edison or cut and paste them into your favorite word processor.

One of the most intriguing and innovative features of the new Edison is that it can not only calculate voltages and currents, but also, for linear circuits, show how these results are derived or mathematically described. For example, you can learn how to use Ohm’s law, how the output of a filter varies with frequency, and how the voltage of a charging capacitor varies as a function of time.

You can see, read, hear, and experiment with a wide assortment of scenarios using the electrical and electronics experiments included with Edison. You can also use the problems included with Edison to practice trouble-shooting. Edison comes with the tools you need to create your own experiments and problems.
Edison bridges the gap between games and serious design. Students and electronics enthusiasts will love playing with Edison as they learn the basics of electronics and take their first steps towards real circuit design.

When you have a question or need help, refer not only to this manual, but also to the on-line help system. Some information can be found only in the on-line help system.
2. **INSTALLATION PROCEDURE**

2.1 **Minimum Hardware and Software Requirements**

- IBM PC AT/486DX or compatible (Pentium or better recommended)
- 256 MB of RAM
- A hard disk drive with at least 200 MB free space
- CD-ROM
- Mouse
- VGA adapter card and monitor
- Microsoft Windows 9x / ME / NT / 2000/ XP / Vista / Windows 7
- Supported Networks (for Network versions): MS Windows NT/ 2000/ XP Server or later, Novell Netware version 3.12 or later, Linux Samba, Citrix Presentation Server

  If the program is copy protected by a hardware key, the minimum hardware configuration includes also a parallel printer or USB port.

2.2 **Installation from CD-ROM**

To begin the installation simply insert the CD into your CD-ROM drive. The Setup Program will start automatically if the Auto-Run function of your CD-ROM has been enabled (Windows-Default). If not, Select Start/Run and type:

```
D:SETUP (Enter) (where D represents your CD-ROM drive).
```

The setup program will start.

**Note:** This software may come with copy protection. For further details see the Copy Protection and the Network Installation sections.
2.3 Following the Installation Steps

EDISON’s Setup Procedure follows the steps standard with most Windows Programs. There are several screen pages where you can enter or change important installation choices, such as Type of Installation, Destination Directory, etc. To continue installation, click on . You can always step back, using the Button. If you do not want to continue installation for any reason, click on . If you elect to cancel installation, the program will ask you if you really want to exit. At this point you can either resume or exit Setup.

2.4 Welcome and Software License Agreement

To begin the Procedure click on Next on the Welcome Page. The first step is the Software License Agreement.

![License Agreement](image.png)

**Note:** By clicking on “Yes” you are agreeing fully with DesignSoft’s Terms and Conditions for using this software.

2.5 Networking options

**Single user license (installed on a local PC)**

Select this option if you have a single user license and want to use a single copy of Edison on a local PC.

However if you purchased a network license and want to use Edison in a network environment you can choose between 2 options.

**Network license (installed on local PCs)**

Select this option if you want to use the server as a license server. In this case the server stores the license information and the software is installed on the workstations. After you’ve installed the package on the first workstation start Edison and select the location of the license information file on the file server then authorize the package. Finally install the software on every other workstation (client) where you want to use Edison. On these stations when you start Edison for the first time you have to locate the license file on the server. No other authorization is required.
Network license (installed on a file server and client PCs)

Select this option if you want to use the server as a file server. In this case the server store the files of the software and the license information as well. You have to select a network share in the destination dialog of the setup and install the package there. Next you have to install the package on the first workstation and authorize it. Select the Run commands from the Windows Start menu, enter the command U:\Edison\NWSetup\NSETUP and follow the instructions. Note that Edison is the main program directory holding Edison on the server. Start Edison on the first workstation. Note that when you authorize the first workstation full access is needed on the network share where Edison is located. Authorize Edison. Finally you must run the setup program on every other workstation (client) where you want to use Edison. No authorization is required on these stations.

![InstallShield Wizard](image)

2.6 Choose Destination Location

Here you can select an Installation Directory other than the one suggested as a default. The default is the Windows Standard Directory for Programs. To change the directory, click on Browse and select a different drive and/or directory from the Choose Folder Dialog.
Note: If you are installing EDISON for Windows to a hard disk that already has an earlier version of EDISON, you must be sure to use a new directory name for EDISON for Windows, such as the suggested directory, C:\Program Files\DesignSoft\Edison, or the working files you have already created will be overwritten and lost. If uncertain, exit setup, copy your EDISON files safely to another hard disk directory or to floppy disks, then resume setup.

2.7 Selecting the Program Folder

Here you can choose where in the Programs Section of your Windows Start Menu the Program Icons will appear. The default is a new sub menu called Edison 5. You can change this name or select an existing Program Folder from the list.

![Edison 5 - InstallShield Wizard](image)

2.8 Select Environment Options

In Edison 5 you can set up the settings, private/shared catalog and temporary folder. The Settings folder stores your personal settings. The private catalog folder will store your catalog files, while the shared catalog folder can be used to share catalog files with other users of the same PC or with other users in the network. The temporary folder stores the temporary files of the software. By default these folders are set to common Windows folders however you may change the folders by pressing the browse button.
2.9 Final check and copying the files

This page lists the settings you have made, giving you an opportunity to check and alter them and step back if changes are necessary. After you click on Next, the Setup Program starts copying the files automatically.

2.10 Completing the Setup

After all the selected files have been copied and the Start Menu entries created, you are asked if you want to place a Shortcut to the EDISON program file on your Desktop. The last page indicates a successful installation and invites you to open and read a file with the latest information about EDISON. We urge you to take a moment and review that file. Click on finish when you’re ready.
2.11 Uninstalling EDISON

You can uninstall EDISON at any time. Note that this will not delete files you have created.

1. To begin Uninstallation choose Edison from the EDISON Start Menu Entries.
2. In the window that appears, double-click on Uninstall Edison.
3. Click on Yes if you are positive you want to uninstall EDISON.

After all the files have been removed successfully, an OK Button appears. Click on it and uninstallation is complete.

2.12 Maintaining or Repairing an Installation

You can modify or repair an existing installation of Edison as follows: Select Settings and Control panel from the Start menu of Windows. Click on the Add or Remove programs icon. Locate your Edison installation on the list and press the Change button (Press the Remove button if you want to uninstall the software). The installer of Edison will start and you can either modify the existing installation by adding or removing components or repair the current installation or uninstall the package.
2.13 Network Installation

To install the Network version of EDISON, you must have administrative privileges on the server machine and you have to share a disk volume or directory on your network, the place where EDISON will be installed. With file sharing users can access EDISON files. The share must be writeable by the administrator user during the installation process.

Therefore, carry out the following steps to make all files in the specified directory shared:

**Novell Netware 3.x:** Logon to the server and perform the following commands:

```
FLAG *.* S SUB
```

**Novell Netware 4.x and later versions:**

```
FLAG *.* +SH /S
```

**Linux server:** You need Samba, a free software suite to provide file services for Windows clients. Logon as root and create a Samba share directory on your Linux system, adding the following section to your `/etc/samba/smb.conf` file, then restart Samba service. Example:

```
[EDISON]
comment = EDISON install folder
path = /EDISON
writeable = yes
admin users = administrator root
valid users = EDISONUserGroup
read list = EDISONUserGroup
store dos attributes = yes
```

Later, you might have problem mapping Linux Samba shares to Windows Vista client. Then check Vista LAN Manager authentication level: open the Run command and type “secpol.msc” and click OK. Go to Local Policies, Security Options and navigate “Network Security: LAN Manager authentication
level" and open it. Change the settings from “Send NTLMv2 response only” to “Send LM & NTLM - use NTLMv2 session security if negotiated”. Once you have done this, Windows Vista will be able to view network drives based on Samba servers.

**Windows Server:** Logon as Administrator and use the NET SHARE command, for example:

```
NET SHARE EDISONFolder="C:\Program Files\DesignSoft\EDISON"
```

Or, you can use the Windows Explorer:
1. Right-click the drive or folder, and then click Sharing and Security.
2. Select the “Share this folder” option and type a Share name.
3. Click the Permissions button and ensure that the administrator have Full control permission and click OK twice.

**Windows Client:**
Next make sure that the clients have a mapped drive set to the network drive containing the EDISON program folder.

To assign (map) a drive letter to a network computer or folder do the following:
1. Open Windows Explorer
2. On the Tools menu, click Map Network Drive.
3. In Drive, select a drive letter, e.g.: G:
4. In Path (Win9x/Me) or Folder (NT/2000/XP/Vista), select from the drop-down list or type in the network drive (server and share name: \MyServer\Volume1 or folder name to which you want to assign (map) a Drive letter (\MyServer\Volume1\Program Files\DesignSoft\EDISON) . Note, that share name refers to a shared folder on the server. On Windows NT/2000/XP/Vista you can use Browse to find the network computer, drive and folder.
5. Set the Reconnect at Logon checkbox, then press OK.

Then execute the installation procedure directed by section 3.1 on the mapped disk volume, that is accessible from the network.

After you have set everything up on the network disk according to the instructions above, you must run the setup program on each client where you want to run EDISON. Using the Run command, start NSETUP from the EDISON\NWSETUP directory. Note, do not double-click on the NSETUP icon, but use the Run command instead to start the program.

When you run NSETUP you must specify the working directory which should be located on a local drive of the workstation. The working directory can be on the network; however in this case the path of this directory must be different on every work station. After you’ve specified the working directory, you may install the optional measurement hardware for EDISON. After running NSETUP, you will be able to run EDISON simultaneously on any number of workstations, just as though each workstation had a single user version.

Network versions are copy protected and need authorization. For the details regarding the special procedures required for authorizing networked computers, refer to section 2.5.

**2.14 Copy protection**

Executing the authorization procedure described in this section, you will be able to run EDISON. If you use a network version of the program, you will be able to do it simultaneously on the number of workstations the program licensed, just as though each workstation had a single user version.
2.15 Copy Protection by Software

If your version of EDISON is copy-protected by software you need to authorize it.

You have to be in Administrator mode when you authorize the program.

**Note for Vista:** Even though you are a user configured as an “Administrator”, Vista treats you as a standard user so the authorization may not succeed unless you make sure that User Account Control (UAC) is enabled in Vista. This is enabled by default, so if you didn’t turn it off manually it should be OK. (You can find this setting in the Control Panel when you enter ‘UAC’ in the search field in the upper right corner of the Window.)

Authorize the program with the following steps:

1. Run **Authorization & Trial** from the Start menu.

2. After the program has started the License Status dialog appears showing your initial authorization status. (If the program starts but the License Status dialog does not appear, select the Authorization/Authorize from the Help menu of the Schematic Editor.) You will normally have 31 trial sessions to provide you enough time obtain the authorization.

   - Press the Authorize button on the License Status dialog which is displayed at program start or select Authorization/Authorize from the Help menu of EDISON.
   
   - Enter your 16 digit Order number into the Order number field of the Authorize dialog appearing and press OK. For successful operation you must be connected to the Internet and your firewall should allow communication with our server.
   
   - If the above is not possible for any reasons select the Other tab on the Authorize dialog.
   
   - Email your Site code to DesignSoft using the link in the Authorize dialog or contact your dealer.
   
   - We will email back a Site key, which should be copied into the Site key field of the Authorize dialog.
   
   - Press OK to finish the authorization.

**Note for Network version:** If you use a network version of EDISON then it will run on workstations where the setup with the NWSETUP program has already been done. It is sufficient to authorize the software at one workstation. This will allow to run the software simultaneously, as long as the total number of simultaneous users does not exceed the licensed number.

In some cases the program comes with a Serial number, which needs to be entered during installation. When entering the serial number you do not need an active internet connection.

For more information refer to the program’s Authorization Help by pressing the Help button.
2.16 Copy Protection by Hardware (dongle)

**Single user version**

Make sure you are in Administrator mode.

If you have a USB dongle-protected version of EDISON, install EDISON first before connecting the dongle.

Next, connect the dongle to the USB port. The dongle driver installation will begin. If Windows looks for the dongle driver, select the recommended option, which is your hard disk.

If the dongle is not connected or not installed correctly the following error message will appear:

```
Hardware protection key is not present (USB).
```

**Site license with multi-user dongle (DS PROTKEY)**

To avoid loss or damage of dongles you may have just one dongle for the whole site. In this case you need the dongle only at the first start of the program at each workstation.

1) Install the software on each computer as described in the manual for single computers, according to the number of licenses purchased for your site.

2) Start the program with the dongle plugged in, then close the program and remove the dongle. After you authorized all workstations this way keep the dongle at safe place. If on some workstations the license is lost for any reasons (e.g. disk crash), you can reinstall the program and authorize again with the same technique. Please do not use this possibility to install the software on more workstations than licensed, because this might eliminate the possibility to recover lost licenses.

**Authorization with network dongle**

If you have a network dongle do the following to authorize EDISON on the server.

1. After setting up the workstations with nsetup (see section 2.4), login on one workstation as Administrator (with writing right to the volume where EDISON resides).
2. Connect the dongle with the above workstation. The system must recognize the dongle and the LED on the dongle should light.
3. Start EDISON. Based on the information in the dongle EDISON will be authorized for the number of users licensed, and a dialog box should appear to confirm this.
4. Remove the dongle and keep it at a safe place, as you may need it to recover the license in case of a system crash.
5. Now EDISON should run on all workstations without the dongle.
3. USING THE EDITOR

3.1 The Screen Layout

Edison has a double panel screen layout. The left main window shows the 3D view of the working area with a component bar and a toolbar on the top of the window.

![Edison Screen Layout](image)

You can pick up parts from the component bar by clicking on them with the mouse. Move them to the working area and drop them into place by left clicking the mouse again. When you move a component over the plug in breadboard, it will change to a plug-in type component (if available). The right panel presents the same parts using standard schematic symbols. You can maximize the left window containing the 3D parts if you do not need the schematics. Once you have become familiar with schematic symbols you may also edit the circuit using the schematic window and its toolbar. You may also run just Edison’s Schematic Analyzer available by pressing the Schematic Analyzer menu from the Edison folder of the start menu.

3.2 Parts

These are the parts available in Edison:

- Solderless breadboard
- Connector
- Simple switches
- Push button
- Alternative switches
- Relay
- Batteries
- DC power supply
• Resistor (color-coded or labeled)
• Potentiometer (variable resistor)
• Electric bulbs
• Electric motor
• Capacitor
• Coil
• Meters (voltmeter, ammeter, ohmmeter, and multimeter)
• Signal generator
• Oscilloscope
• Signal analyzer
• Speaker
• Bipolar transistors (NPN, PNP)
• Enhancement-type transistors (NMOS, PMOS)
• Diode
• LED
• Logic gates (AND, OR, NAND, NOR, NOT, XOR)
• Ground
• Operational Amplifier (741)
• Timer (555)
• Flip-flops (D, JK, Latch)

Note that we use the words “component” and “part” interchangeably.

3.3 Using the 3D Editor

Most Edison commands are carried out with the mouse. Depending on the position of the mouse the buttons behave differently. For example, if you place the cursor over the table and press the left button, you rotate the table around the center of the viewing area but if you move the mouse over a component the left mouse button may select the part before moving/deleting it or press a button on the component etc.

The left button of the mouse plays a confirming role. For example, you use the left button to pick up parts, change switch settings, select a component, or move a control bar. The right button serves to interrupt an action or pop up a local menu on components.

You can set the 3D camera position by simply using your mouse. Click and hold the left mouse button on the table or on the background to rotate the table around the screen center. Click and hold the right mouse button and move the mouse up or down to zoom the table. Click and hold both the left and right mouse buttons to pan the table horizontally (in the x-y plane).

You can pick up a part from the component bar by clicking on the component’s button. Move the part over the table in the working area and place it by pressing the left mouse button again. Parts can be rotated by pressing the * key on the numeric keyboard while the parts are being moved.

If you have already placed a part and want to rotate it, click on it to select and choose the rotate left/right button from the toolbar, or press the right mouse button over the part and select the rotate left/right menu. To relocate a part simply click and hold the mouse over the part and drag it into a new position. You may select multiple parts to move/rotate by pressing and holding the Ctrl key while clicking on them. Alternatively, you may also draw a selection rectangle with the mouse around the parts you want to select simultaneously. Press and hold the right mouse button over the table and wait until the cursor shape changes to . Move the mouse diagonally to draw a selection rectangle then release it to activate the selection.
To cancel the placement of a part, press the right mouse button or the Esc key.

Parts dragged by the mouse on the table usually move horizontally in the table’s plane. If you want to lift a component (e.g. to put it on the top of another element), press and hold the Shift key while dragging the component with the left mouse button.

You may also change the size of the components in the 3D view by selecting them and pressing the numeric + or – on the keyboard.

When placing a component in the 3D view, its schematic version is also placed on the right side. You can freely move the schematic symbol or wire on the right (schematic) side by clicking and dragging. This will not affect its original placement on the left side, and its original connections will be kept. You can use this technique to make the automatically generated schematic diagrams neater and more readable.

In Edison 5 you may also use the schematic editor to create your circuits. Select a part from the componentbar of the schematic window and place it into the schematic area. The corresponding 3D part will be automatically inserted in the 3D view. You may connect the parts with a wire by clicking on the connectors.

3.4 Using the Plug in Breadboard

One of the most significant innovations of Edison 5 is the virtual breadboard. Breadboards, or plug boards, or white boards, as they are sometimes called, are used for testing and experimenting with electronic circuits. They are very convenient since they provide many groups of connection points with internal connections. All you have to do is plug in the components and add wires to complete your circuit. Edison’s virtual breadboard makes building circuits extremely easy since it can show the internal connections whenever you need them and can also show how the parts already placed are connected.

The startup screen of Edison 5 does not contain the breadboard. As described in the previous section, you can drag and drop parts to your worktable and connect them with wire using the mouse. This technique is easier to follow and perhaps even better for explaining circuit operation. However, if you wanted to assemble a real circuit on your workbench, you would need a soldering iron and special connectors to connect the parts and wires.

It is much easier to assemble a real circuit using a breadboard, which can be perfectly simulated in Edison’s virtual breadboard. To place a breadboard on the worktable, select and place the white breadboard from the general tab of the component bar on the table. You can use as many breadboards as you wish by placing them on the table one-by-one.

When you have a breadboard, you can place parts either on the breadboard or on the worktable.

The appearance of certain components (batteries, switches, meters, etc.) is the same on the breadboard, and the worktable. Other components which have plug-in terminals (e.g. ICs) change their form when moved above a breadboard. The terminals of these parts are automatically connected to the respective connectors in the holes on the breadboard. While moving such a part above the breadboard, its connection wires follow the body of the component and they jump from hole to hole. If you want to take control and plug the terminals into positions different from the automatic ones, place the component then click on the connection wire in the hole on the breadboard and drag it into a new hole. In case the program is unable to connect a terminal into the breadboard (because there is no empty hole under the terminal where you placed the component) you can connect the omitted terminals by clicking on the terminal and dragging it into a hole while pressing and holding the Ctrl key. If – at any time – you want to make your circuit look nicer or just simply need more room around a breadboard
hole, you may reposition already connected elements without losing their connection. To do so, simply click on the element and drag it into a new position while pressing a holding down the Ctrl key.

You can also modify the route of the wire by dragging any of its internal handles. When the cursor is in a position to drag an internal point of a wire, it changes to a drag symbol. Modifying an internal point of a wire will also modify the neighborhood of the point to keep the wire route smooth.

There are a few options for the use of the breadboards in the Options menu. Check these options and try them out, as they can significantly improve the efficiency and speed of your editing.

**Show breadboard's internal connections**

While moving with the mouse above the breadboard, Edison will show the internal breadboard connections under the mouse. While this option is useful during circuit creation or editing, it sometimes is disturbing (e.g., during demonstrations). In that case you, can disable it.

**Show breadboard’s circuit connections**

The program will show the internal breadboard connections in use. This helps to check if your parts are plugged into the proper place.

### 3.5 Creating an Electro-Mechanical Experiment

A very new and unique feature of Edison 5 is the ability that it can be used to create and simulate not only electronic circuits but also circuits containing mechanical parts like gears, pulleys or racks. To create a circuit with mechanical parts simply place the components from the Mechanics tab of the component bar move them close to each other. It a mechanical part can be connected to another mechanical part (or electric motor) it will automatically snap to the other component. For instance, gears and pulleys can be snapped to motors, axes (vertical or horizontal), or each other.

### 3.6 Selecting Between Component Groups

The components available in Edison are grouped on tabs of the component bar at the top of the window. You can switch among the component groups by clicking on the tabs below them. To help identify a component, move the mouse over it and see a hint giving the component name. This hint can be enabled or disabled though the Hints above shelves command in the Options menu.

### 3.7 Adding, Deleting and Modifying Wires

After you have placed the parts in the working area or on the breadboard, it is time to connect them with wires. To start a wire run, move the cursor toward one of a component’s connection terminals until the cursor changes into a small plus with a plug. Press the left mouse button and start to draw the wire. You can draw along any curve and Edison will create a smooth path. If you move the mouse along the table the wire will follow the table’s plane, if you move it over a component it will rise up from the table to dodge the other part. You end a wire by moving the cursor to the second terminal and clicking the left mouse button. The starting or ending terminal of a wire can also be any unoccupied terminal of a breadboard.

If a wire route is not right, press the right mouse button to go back step by step. You can also cancel the whole wire by pressing the escape key (Esc).

To remove a wire, you must first select it. Position the pick-up cursor over the wire at any point and click the left mouse button. The wire will turn white, and you may press the Delete button to delete the wire. If you want to deselect a selected wire, press the left mouse button somewhere else. Deletion of a wire can also be managed by right clicking on the wire. A popup menu appears and you choose the Delete option.

You can also modify routing of the wires. Press the left mouse button when you see the drag symbol, and hold the button down while freely moving the mouse. See how Edison will at first just refine the wire
path, or will create a new path if you lead your mouse over a new path. You can also change the connection points in the breadboard of a wire using the drag and drop feature. When the cursor is in position to drag the endpoint of a wire, it changes to a hand symbol. If you drop the end point of a wire at a point which is not a connection point, the operation will not be performed.

When drawing wires in Edison 5, keep in mind that the wires in the schematic diagram are also being generated at the same time. Edison tries to make neat right angled wires from the freehand wires you draw. Keep an eye on the schematic and check that the “schematic wire” is acceptable. If not, go to the right side and modify the path of the wire as you wish. To do this, first select the wire, then drag and drop any part of the wire using its “anchor” points.

You can also modify the color and the width of a freehand wire: Double click on a wire and set the parameters appearing in the dialog box.

Note that the hidden connections in use in a breadboard are automatically shown in the schematic diagram and can be also shown on the breadboard if the “Show breadboard’s circuit connection” switch in the Options dialog’s Simulation page is on.

3.8 Selecting, Moving and Deleting Parts in the Working Area

To select a part, move the cursor over the part, find a place where the cursor changes to a drag symbol, then press the left mouse button. When a part is selected, a white frame appears around it.

Note that for some components, especially those which have buttons or displays, left clicking has a second function when over some areas of the part, e.g., at a switch's button. Depending upon the kind of part, left clicking at a given place will change a switch setting, turn a potentiometer, increase a parameter, etc. When you are above such areas the cursor will turn into a hand symbol. In the following text we refer to such areas as “active” areas.

Other areas, where the cursor turns into a drag symbol, we will call “neutral” areas, because a simple click just results a selection.

Multiple selection: Hold down Ctrl button while you are selecting the components one by one. Alternatively, you can also right-click somewhere on the table or the background, wait until the cursor changes to a multiple drag icon and drag the mouse to draw a selection rectangle. Every component which falls inside the selection rectangle will be selected.

If you want to delete one or more parts, select them in the above way, then press Delete. All selected components will be deleted. When you delete a part, all its connecting wires will also be deleted - no unconnected wires can remain on the worktable.

To move a part to a new location, place the cursor over the selection area of the component and hold down the left mouse button. By holding down the left button, you can drag the part and drop it in a new location. Note that in Edison when a part is dragged, all wires connected will be moved accordingly.

A very convenient feature of Edison is that if you need to move a component or terminal wire already plugged into the breadboard, you can do so by dragging and dropping. Press the left mouse button on the component body or at the end of a terminal wire plugged into the breadboard, hold the mouse button while moving, and release the button when you have reached the desired place. Dragging the component by default will tear it out from the breadboard, the “rubber wires” will go away, and you can move and place the component again just like a new one. If you want to move the component and still preserve its breadboard connections, press and hold the Ctrl key while dragging the part.
Edison has three different modes of operation. By default, Edison is in the DC/AC mode, which assumes that all the currents and voltages are either constant or changing sinusoidally. Edison presents the DC value of (DC) currents/voltages and the effective or peak values of (AC) alternating currents/voltages. Edison has two more modes that are used to simulate circuit operation with arbitrary varying currents (e.g., charging capacitor). These modes are set using the control panel, shown below.

### DC/AC mode
- Single transient mode
- Continuous transient mode

**DC/AC mode** Edison calculates the currents and voltages and displays them on the instruments. The animated components (lamp, motor, LED, etc.) will operate according to their actual average voltage or current.

**Single transient mode** Pressing the Start/Stop button or any switch in the circuit tells Edison to carry out a single simulation from zero time to the time set in the Edison simulation options. Note that the time set in the Control Panel also affects the actual execution time of the simulation. The default simulation time is 1s, if the speed of the computer allows that. For example, if the value set in the control panel is 1ms, then the simulation time of the 1ms process will be 1s. While the analysis is running, the animated components will operate according to their instantaneous currents and voltages. An important use of this mode is to obtain a diagram or formula of the simulated process. When the simulation is finished, (the Start/Stop button pops out), move the cursor over a voltmeter, ammeter, or oscilloscope. Click the right mouse button and select *Diagram* in the popup menu. Similarly, you can get the mathematical formula describing the process (linear circuits only) by selecting *Formulas*.

**Continuous transient mode** Pressing the Start/Stop button or any switch on the breadboard tells Edison to carry out a continuous simulation. The speed of the analysis depends on the time value set in the Edison simulation options dialog. The larger this value, the faster the simulation time. While the analysis is running, the animated components will operate according to their instantaneous currents and voltages. Pressing the Start/Stop button will not stop the simulation immediately: simulation will only stop when the next integer multiple of the time value set at the control panel is reached. To see a diagram of the last analysis (covering the period indicated by the analysis time set at simulation options dialog), move the cursor above an instrument or oscilloscope and press the right mouse button and select diagram.

### Drawing Diagrams

In addition to the oscilloscope that presents the time function in “real time” during the simulation, you can get high quality diagrams after the simulation is finished. When a single or continuous simulation run is finished (the Start/Stop button pops out), move the cursor over a voltmeter, ammeter, or oscilloscope and click the right mouse button. Then select *Diagram* in the popup menu.
3.11 Deriving Formulas

One of the most innovative features of Edison is that it can not only calculate voltages and currents, but can also (for linear circuits), show how these results are derived or mathematically described. In DC/AC mode, this means that the program will give you a detailed solution showing how the numerical result was derived. Position the cursor over a voltmeter or ammeter, press the right mouse button, and select Formulas. To get AC formulas, you must select Formulas above a multimeter in AC mode.

Note that this is only possible for linear circuits containing resistors, capacitors, coils and batteries. Nonlinear components, such as transistors, diodes, and ICs, are not allowed. In most of these nonlinear components, it is simply not possible to describe the result with formulas. However, you can still use simplified linear models for semiconductors and derive formulas for them in the Schematic Analyzer included in the system.

There are two more ways to derive formulas in Edison.

Clicking above a Signal Analyzer, you can get the transfer characteristic of linear circuits: functions describing the circuit’s amplification or attenuation as a function of the complex frequency, $s=jw$. For example, you can get the frequency response of a filter.

Clicking above an Oscilloscope, voltmeter or ammeter, you can get the time response in the form of a formula describing the selected voltage or current as a function of time. For example, you can get the voltage or current of a charging capacitor as a function of time.
4. GETTING STARTED

To start Edison, click the Start button, select the Edison 5 folder, and click on Edison. From the File menu at the left-hand side of the screen, select the Open command. From the list that appears, select EXAMPLES\MEVDIV.CIR.

Move the cursor over the switch and see it change into a hand symbol: click the switch to see the output voltage go on and off. Then, leaving the switch on, move the cursor over the voltmeter in the left window and click the right mouse button. The following pop-up menu will appear: Diagram/Formulas/Delete etc. Select Formulas and note the dialog box that appears giving the solution and showing how the voltage was calculated.

Copy the formulas to the clipboard with Edit/Copy or Ctrl-C and paste them into the schematic diagram (using Edit/Paste in the right window or clicking on the right window and then pressing Ctrl-V).

You can print the left or right side windows by using the print command while in the respective window.

4.1 Building and Analyzing Circuits

Let’s build the RC circuit shown in the figure below. Note that you can find this circuit in the EXAMPLES directory (EXAMPLES\RC.ECIR).

Click the 9V battery in the component bar’s basic group. The cursor will pick up a battery which you can move anywhere on the left side area. If you move it above the table it will fall down and remain in the plane of the table. Once you have placed the element on the table it cannot be moved beyond the edges of the table. Note that the schematic symbol of the battery will appear at the same time in the right window. Now press the * key on the numeric keypad to rotate the battery by 90 degrees.

Let’s add the resistor and the switch from the same, basic group. Before dropping them into place, check the schematic diagram in the right window and make sure that the parts are on the same horizontal line. Now let’s change the value of the resistor (by default, the first resistor entered is set to 100 Ohms). Double-click on the resistor in the left window to get the Properties dialog box. Click in the Resistance field and change the value to 1k. Now pick up a capacitor, rotate it with the * key, and drop it into place, once again taking care to maintain horizontal alignment in the schematic diagram. Change the value of the capacitor to 1u. To access the voltmeter and the oscilloscope, click on the Meters tab below the component bar. Now drop the oscilloscope and the voltmeter as shown above. Double click on the oscilloscope and set the B channel amplitude to 5 and the Time interval to 10m. Note that you can also set these values by clicking the control buttons.
Finally, let’s connect the parts with wire. When you position the cursor over the terminal of a part, the cursor changes to a small plug sign. Click the left mouse button and use the mouse to trace the wire. When the wiring cursor reaches the target terminal, the cursor once more changes to a small plug sign. Click the left mouse button to end the wire. Note that the wire tries to dodge all element that are in its way as you draw it, so if the mouse moves above the table the wire tries to follow the plane of the table, but if you move it over a component it will raise up from the table and go above the part. While extending the wire, pay attention to the schematic window and try to make the wiring neat. With a little practice, you will be able to create professional looking schematics and neat, easy to read wiring diagrams at the same time. Nevertheless, after placing the wire you can still edit it both in the schematic window and in the 3D view by grabbing and dragging the wire somewhere in the middle. Moreover, if a wire is easier to connect in the schematic window you can do it there and adjust the wire later in the 3D window.

4.2 Transient Mode

To see how the capacitor acquires charge, click the down arrow button beside the “Run analysis” button on the toolbar and select the Options menu. Now the options dialog will popup with the simulation tab displayed. Set the analysis time to 10m and press OK. Finally click on the switch button in the circuit. This will start the transient analysis and draw the result on the oscilloscope.

To get a more accurate picture of the charging curve (with greater detail and easier to read values), move the cursor over the oscilloscope. When the cursor changes to a drag symbol, press the right mouse button. From the popup menu that appears, select diagram and a detailed diagram appears in a new window.
4.3 AC Analysis

To demonstrate Edison’s AC analysis capabilities, load the circuit (EXAMPLES\ RCAC.CIR).

In this circuit, the sinusoidal input and output voltages of an RC circuit are shown. The 3D voltmeter displays the output amplitude, while the schematic voltmeter displays the phase. You can also see the amplitude and phase difference on the oscilloscope. Change the frequency of the generator and observe how this affects the results.

4.4 AC Characteristic

To see the AC characteristic of the same RC circuit, load EXAMPLES\RCSIGAN.CIR.

To obtain the circuit frequency response (frequency characteristic), click the Signal Analyzer Run button and move the cursor over the Signal Analyzer. When the cursor turns into a drag symbol, press the right mouse button. From the popup menu that appears, select diagram: a detailed diagram (showing the same results as the signal analyzer) appears in a new window.
4.5 Building a Circuit Using a Breadboard

Let’s build a circuit using the breadboard shown in the figure below. Note that you can find this circuit in the EXAMPLES directory (EXAMPLES\NOTGATE.CIR).

Select the File.New menu. Pick up a breadboard from the Basic group of the componentbar and place it in the middle of the table.

Select a 4.5V battery on the component bar. Press numeric * to rotate the battery by 90 degrees.
Now select the digital tab and click on the NOT gate and start moving it. Place this part on the middle row of the breadboard. Note that ICs should not be placed on any other location on a breadboard, because their output terminals would be connected (shorted) by the hidden breadboard connections.

Drag and drop an alternate switch according to the figure. Note that normal switches and alternate switches are located on separate tabs.

Now let’s connect the battery to the IC. The positive terminal of the battery should be connected to the Vcc pin of the IC. Before starting the wire, one should locate which terminal of the IC will be connected. This can be done in two ways. One can read the labels of the IC on the right side schematic diagram, or the same labels can be read in the statusbar on the left side by moving the cursor close to the terminals of the IC. Once Vcc is located, start a wire at the upper terminal of the battery. The end point of this wire should be one of those terminals of the breadboard which are internally connected to the Vcc terminal of the IC. If the “Show breadboard’s internal connections” option is allowed, one can easily locate which connections are built in the breadboard. Now connect the - terminal of the battery to the left-most hole of the five internally connected holes at the bottom of the breadboard. Then connect the second hole with a wire to the Ground pin of the IC using a vertically placed internal connection of the breadboard.

Now connect the terminals of the alternate switch to the battery and to the A1 pin of the IC according to the figure. Note that real logic ICs always contain several gates. In this case the IC contains 6 NOT gates, which can be used separately. In this presentation, we will use only gate #1.

The LED should now be placed on the breadboard. Let’s first simply drop it somewhere near its position in the figure. Once it is placed, we can easily adjust its position on the breadboard. Click on the body of the LED and drag it slowly to final position. Now drag its left terminal to one of those terminals of the breadboard which is internally connected to the Y1 pin of the IC. Similarly connect the other LED terminal to the position shown in the figure.

Finally, place the resistor on the breadboard and connect it to the LED as shown in the figure. Double-click on the resistor and set its value to 220 Ohms.

You can easily check the connections by looking at the right hand panel.

Now we can test the circuit. If every connection has been made correctly, the NOT gate will function properly: the LED will light when Ground is connected to the A1 input of the gate, and vice versa.

To finish the circuit, you may want to make some adjustments on the right side. Drag and drop components to make the schematic neater and easier to follow.

4.6 Building a PIC Circuit

Let’s build a PIC flasher circuit using the breadboard shown in the figure below. Note that you can find this circuit in the EXAMPLES directory (EXAMPLES/PICFLASHER.ECIR).

The circuit will flash the LEDs. At first the first led will light, after that the second, third and fourth led. Only one led will light at the same time.
Select the File.New menu. Pick up a breadboard from the Basic group of the component bar and place it in the middle of the table. Select a *Cased Battery 3.0V* on the component bar. Now select the digital tab and click on the *PIC Processor* and start moving it. Place this part on the middle row of the breadboard. Note that ICs should not be placed on any other location on a breadboard, because their output terminals would be connected (shorted) by the hidden breadboard connections.

Now we will assign a program to the PIC using the Flowchart tool of Edison. Double click the yellow PIC processor on the Schematic Editor side, at the right side of the screen, and click on the *Flowchart* entry, in the upcoming *MCU Input File selection* dialog select Flowchart, the Flowchart editor appears.

Select a Start symbol and place to the editor, select a *Set variable* symbol and change the *Value or variable* field to 1. Place the symbol immediately after the Start symbol. When you place the symbol immediately after the previous symbol you don’t need to connect them with flowchart wires.

Select and place an *Output data* symbol, set the *Value or variable* field to x1. Select and place an *Change variable* symbol, change the operator field to * and change *Value or variable* field to 2. Select and place a *Test variable* symbol, change the operator field to >, and change the *Value or variable* field to 8. Connect the Y case after the Start symbol, and connect the N case after the x1=1 symbol.

The program will produce the following sequences: 0,1,2,4,8, … 0,1,2,4,8,0... on PORTA, which will ensure that only one led will light at the same time.

When the flowchart is complete, will look like this:
Check the flowchart with the Check Flowchart button. You can switch to the Code tab, to check the generated assembly code. Press the Save to Macro button, and select OK to save the flowchart.

Now we will go back editing the circuit. Select LED from the Semiconductors tab and place it to the breadboard, put 4 LEDs. Select Labeled Resistor from the Basic tab and place it to the breadboard, keep the 100 Ohm value, put 4 resistors. The breadboard will look like this:

Now we will connect these circuit components. We will connect the resistors to the PIC processor RA0-RA3 pins, and the resistor’s second terminals to the LEDs, the LEDs second terminals to the VSS pin of the PIC processor, and the + pole of the battery to the VDD pin of the PIC.
When you move the mouse over the breadboard, the columns will be highlighted with light red, it means this points connected electrically to the same point. When putting the LEDs and the resistors, the second terminal of the resistor and the first terminal of the LED automatically connected to each other, because these terminals are in the same row of the breadboard.

While you built the circuit on the breadboard the program has automatically made the schematic diagram on the right side of the screen. You should get a screen similar to the below.

To test the circuit change the interactive mode to \textit{Transient continuous} on the toolbar, and press the \text{Play} button to start the interactive simulation.
You can also follow the operation of this circuit step-by-step using the built in debugger of the Flowchart tool in Edison. To do this release the button and set the Analysis/Enable MCU code debugger switch in the Analysis menu of the Schematic Editor at the right side of the screen.

Now press the button again. The MCU code debugger will appear.

You can run the program continuously by pressing the Run button, step-by-step by pressing the Step forward button or stop the program by pressing the Stop button. The debugger will show the active flowchart component by setting its background color to yellow.

There are three important tabs at the top-left corner of the debugger that establish the view of the source. If you select the Flowchart tab, you can see and debug via the Flowchart. If you select the Flowchart+Code tab, the debugger will display both the flowchart and the assembly code. You can, in this view, place breakpoints both in the flowchart and in the assembly code. If you select the last mode, Code, you can debug using traditional assembly language debugging. For more information on this topic see the 7.7.5 Microcontroller circuits chapter of this manual.

4.7 Building an Electro-Mechanical Circuit

Let’s build a circuit with mechanical parts. First select the mechanics tab on the component bar. Select a cased motor and place it on the table. From the basic tab also select and place a 4.5V battery and a switch next to the motor. Now connect them with wires. Click on one of the terminals of the battery, move the mouse above the terminal of the motor and finish the wire with a left mouse click. Also connect the other terminal of the battery with one of the terminals of the switch, and finally connect the unused terminal of the switch with the unused terminal of the motor. Now, if you click on the switch you can see, that the motor is turning.
Now let's add mechanical parts to the motor. Turn back to the mechanics page on the component bar. Select a pulley from the component bar and start moving it above the table. As you move the pulley close to the axis of the motor, the pulley will automatically snap to the motor and remain there. Finish the placement with the left mouse button. Now select a horizontal axis from the mechanics parts and place it somewhere next to the motor. Snap another pulley in the middle of the axis and move the axis closer to the motor. If you move it close enough, the two pulleys will automatically "connect" and a black belt will appear around them. Double click on the second pulley to bring up its properties dialog. Set the size to 20 so the pulley on the axis will be almost half the size of the other pulley.
Note that the mechanical parts are not displayed in the 2D schematics window, only the electrical components.

Now if you turn on the switch again the motor will start turning, which will turn pulley and the pulley will turn the other pulley. Now let's continue the mechanical part of the circuit with another horizontal axis with a large gear and connect the two axis with bevel gears as indicated in the picture. All these elements will snap into their place as you move them. Finally place a rack under the large gear and turn on the switch.

As you can see the rotation of the motor in several steps – via pulleys, bevel gears and the axis itself – will be transferred to the large gear that will finally push out the rack onto the table. If you want to repeat this experiment, turn off the motor with the switch and by holding the mouse pointer above the large gear turn the gear back to its initial position with the mouse scroll button.
Here is a list and description of the parts available for building circuits in Edison. Most parts (except connectors and boards) have an error status parameter and can be in an operational or in a faulty state as noted below.

5.  THE PARTS

5.1 Connector

Use a connector to join wires. Each connector permits an unlimited number of connections (i.e. you can connect an arbitrary number of wires to a connector). A connector has no electrical effect on a circuit and has no error status.

5.2 Simple Switches

The simple switch functions as a single pole/single throw switch (SPST), with push on/push off action. Move the cursor to the vicinity of the switch button. When the hand symbol appears, press the left mouse button to change the switch setting. Take care not to position the cursor on the switch terminals (you’ll see the little wiring circle) or you will jump to the wiring function. If this happens, press Esc. If you want to select a switch, left click on a neutral part of its shape (usually located on the bottom of the switch). Error status: None/Open.

5.3 Push Button

This part is similar to the simple switch except that its switching action is momentary: the terminals will be connected only while you are holding down the left mouse button. Error status: None/Open.

5.4 Alternative Switches

This switch is a single pole/double throw switch (SPDT) and has three terminals. Depending on the position of the button, the middle terminal (often called the “wiper” or common terminal) is connected to one of the terminals on the sides. Error status: None/Open.

5.5 Relay

A relay is a controlled switch. Edison’s relay has three terminals arranged as in an alternate switch. When the current in its coil reaches a certain value (35mA by default), it changes the connection of the three terminals just like the alternate switch.
5.6 Batteries

Edison offers several batteries as DC sources:

- **1.5 V battery**
- **4.5 V battery**
- **9 V battery**

- 3 V battery from two 1.5 V pencil batteries connected in series

- 6 V battery from two 3 V button batteries connected in series

These batteries are similar to typical low voltage batteries.

The batteries have an internal resistance parameter which can be zero (default) or user-defined. You can specify the internal resistance by using the **Edit.Modify Parameters** command or double-clicking on the part. Error status: None/Run-down.

5.7 Power Supply

This part is like a typical lab variable DC power supply with a digital voltage display. You can quickly make voltage adjustments with the front panel buttons. To change the voltage in large steps (1 V as default), left click and turn the left button. Turning it clockwise will increase, turning it counterclockwise will decrease the generated voltage. You may also use the scroll button of your mouse to change the voltage, while keeping the mouse pointer above the button. To change the voltage in small steps, use the right button of the power supply in the same way. If you right click on a button you can also enter the desired voltage in a popup window.

You can change the power supply voltage limits, increments, etc. in the Properties dialog through the component’s popup menu Properties command or by double-clicking on the power supply on a neutral part of the shape. Error status: None/Open.

5.8 Resistors

Edison offers two resistors, each operating the same way but differing in appearance. The color-coded resistor indicates its actual value with standard color coding. The printed resistor has its resistance printed on it. Note that the Shift bar changes the basic color of the color coded resistor.

You can change the resistance through the **Edit.Modify Parameters** command or by double-clicking on the part. When you have set a new resistance value, the default resistance value will change to this value. If you then pick up another resistor from the shelf, its value will be the new default value. Error status: None/Open.
5.9 Potentiometer (Variable Resistor)

A potentiometer is a variable resistor with three terminals. There are two kinds of potentiometers available in Edison. One is controlled by a slider, the other by a rotary knob. The sliding contact (“slider”) linearly divides the total resistance between left and right connections. The slider can be dragged and dropped to the desired position.

The potentiometer with the rotary knob also divides the resistance between the two end terminals. If you click on the knob and move the mouse around the center of the knob, it will turn it in the corresponding direction. Similarly you can use your mouse’ scroll button while keeping the mouse pointer over the knob.

The total resistance end to end is 50 ohms by default, but this-and the actual division-can be changed through the popup menu Properties command or by double-clicking on the part. It is important that you double-click only at a neutral place, where clicking will not induce other actions. The actual settings of a potentiometer can also be seen in the statusbar by moving the cursor above it. Error status: None/Open.

5.10 Electric Bulbs

The bulb (lamp) will burn brighter or dimmer depending on the applied voltage. If the voltage is too high, the bulb will burn out.

Bulbs are available in several sizes and bulb holders. You can select an alternative bulb by pressing the Shift key or the numeric – key while moving. To change the direction of the lamps, press the Ctrl key or the + key on the numeric keypad. By default, they are all of the same nominal voltage and power. The higher the power, the lower the bulb resistance. These parameters can be changed with the Edit.Modify Parameters command or by double-clicking on the part. Error status: None/Burnt out.

5.11 Electric Motor

The electric motor accepts either DC or AC power and will turn faster or slower depending on the applied voltage. When supplied with DC voltage, the direction of rotation will depend on the polarity of the voltage.

Like the electric bulb, the motor has power and voltage parameters which can be changed with the Edit.Modify Parameters command or by double-clicking on the part. Error status: None/Open/Shorted.

5.12 Capacitor

The capacitor’s value (its capacitance) is visible on the right panel, but can also be displayed by moving the cursor over the capacitor if “Hints above circuits” is enabled in the Options menu. Capacitance values are typically expressed in F (farads), uF, nF, and pF.

You can change the value through the popup menu Properties command or by double-clicking on the part. Error status: None/Open/Shorted.
5.13 Coil

Edison offers a coil component (inductor) whose value (its inductance) is visible on the right panel, but can also be displayed by moving the cursor on the coil if Hints above circuits is enabled in the Options menu. Inductance values are typically expressed in H (Henries), mH, or uH.

You can change the value through the Edit.Modify Parameters command or by double-clicking on the part. Error status: None/Open/Shorted.

5.14 Meters

Edison offers voltmeters, ammeters, and ohmmeters - all with digital display. The red terminal represents the positive input and the white terminal the negative. They are considered ideal meters. Error status: None/Open.

There is also a multimeter with five different functions. It can work as:
   - Direct current voltage meter
   - Alternating current voltage meter
   - Resistance meter (ohmmeter)
   - Direct current ampere meter
   - Alternating current ampere meter

To select a function, click on the appropriate label, which will turn the main switch of the multimeter to the required position. Some functions are not available on the front panel and can be reached by double-clicking the multimeter at a neutral place.

5.15 Using the Increasing/Decreasing Buttons

Edison offers increasing/decreasing (arrow) buttons for the signal generator, oscilloscope, and signal analyzer. The step size between values is a function of the present setting of the total range.

If you hold a button down, the value will continuously increase or decrease. If you hold the button down for a longer time, the step size will be increased 10 times, allowing you to quickly cover a bigger range.

5.16 Signal Generator

The signal generator generates an alternating voltage at the displayed frequency, amplitude, and phase. The signal is always a sine wave.

The signal generator is designed so that you can quickly change the most important parameters directly from the front panel. By using the increasing/decreasing buttons you can increase or decrease a parameter, this is a fine setting. Clicking on the rotary knobs turns them in big steps. You can also hold down the mouse button on a knob to get a continuous change. Front panel knobs are available for:
   - Frequency
   - Amplitude
   - Phase
Other parameters can be changed through the **Edit.Modify Parameters** command or by double-clicking on the generator at a neutral place. Error status: None/Open.

### 5.17 Oscilloscope

The oscilloscope can display two channels simultaneously. Channel 1 data appears in a dark green curve and channel 2 in light green. Terminal 1 and terminal 2 represent the positive input of the respective channel. The ground is common for both channels. Below the scope’s screen there are numerical displays. The first shows horizontal delay, the second shows the horizontal time value per division, and the third and fourth show the channel 1 and 2 maximum amplitude. The horizontal, time parameter applies to both the channels. Other parameters which are not visible in the screen can be displayed by using the direct set buttons (position) or by double-clicking on the part. You can get a detailed results diagram in a separate window by right clicking on the part, and selecting diagram from the popup menu.

The oscilloscope is designed so that you can change the most important parameters directly from the front panel. By using the increasing/decreasing buttons, you can increase or decrease parameters in steps, or you can right-click on any of the buttons to open the direct set menu to directly enter the numeric value of the corresponding parameter.

These parameters can be changed also through the popup menu Properties command or by double-clicking on the part by double-clicking on the oscilloscope at a neutral place. When the Auto button is depressed, Edison automatically sets the displayed amplitude, origin, and time of both channels for a good presentation.

### 5.18 Signal Analyzer

The signal analyzer is used to obtain the AC transfer characteristics of a circuit. It generates a series of sinusoidal test signals from the start frequency to the stop frequency, at the specified signal amplitude. The number of frequency steps is set by the specified number of samples. You should connect the signal analyzer ‘Out’ terminals to the input terminals of the circuit to be tested. Next, connect the In terminal of the Signal Analyzer to the output of the circuit being tested. The ground is common for both the ‘Out’ and ‘In’ terminals, and must be connected to the circuit! Push the ‘Run’ button to start the signal analyzer’s ‘sweep’. You can get a detailed diagram in a separate window by right clicking on the Signal Analyzer, and selecting diagram from the popup menu.

The signal analyzer places the most important parameters directly on the front panel so they are easy to change. You can increase and decrease the start and stop frequencies (in decade steps). The start and stop frequencies are displayed to the left and right of the analyzer’s message line. Press the ‘Mode’ button to change the display mode to ‘linear [V]’ (displays the output in volts), ‘linear [amplification]’ (displays the ratio of the output to the input in volts/volt), and ‘logarithmic’ (displays the ratio of the output to the input in dB) modes. The active display mode is shown in the message line of the signal analyzer.

By using the increasing/decreasing buttons, you can increase or decrease parameters in steps, while by using the direct set buttons you can directly enter the numeric value of the following parameters:

- Displayed maximum amplitude
- Displayed minimum amplitude
- Signal amplitude
The auto button is used for automatic setting of displayed amplitude.

Other parameters can be changed through the Edit.Modify Parameters command or by double-clicking on the part.

The signal analyzer always waits for the circuit to settle after each change of frequency before measuring the circuit output. The signal analyzer always waits the specified gap time between samples. However, if the fast mode is enabled, the signal analyzer does not wait between samples. Furthermore, in the fast mode, Edison holds off the display of changes in the circuit (measurements, intensity of the bulbs, sounds, etc.) until the process finishes.

5.19 Speaker

The speaker transforms the AC voltage presented to its terminals into sound. By default, like a piezoelectric speaker, Edison’s speaker has a high resistance (1M). Of course, just like a real speaker, it is able to play back multiple frequencies at the same time. To get such an effect, connect two signal generators in series with the speaker, or build two independent circuits each with its own speakers.

This is a good way to demonstrate the phenomenon of beating. Set up two signal generators whose frequencies differ only by 1 or 2 Hz and connect them to a speaker.

Note that the Speaker operates in DC/AC mode only.

5.20 Semiconductor Components

Edison offers a large range of semiconductor components: diodes, LEDs, bipolar and MOS transistors, logic gates, PICs, flip-flops, operational amplifiers, and timers are all available as 3D components from Edison’s shelves. Note that if you want to place an IC on the breadboard, you must place it in the middle strip because in any other position the breadboard’s internal connections would short IC pins together.

Further semiconductor components (e.g. logic ICs) are available in Edison’s Schematic Analyzer. In Edison’s 3D Lab only the forward current gain (β) of bipolar transistors and the threshold voltage of MOS transistors can be changed by double clicking on the part. All other model parameters, of any semiconductor device, can be set in the schematic window.

5.21 Fuse

Edison offers a fuse which automatically breaks the circuit and remains open if the current exceeds its maximum current. While open it has an error status: Open. The parameters can be changed through through the popup menu Properties command or by double-clicking on the part. If the fuse burns out, you can repair it using the Repair command in the edit menu (or toolbar).

5.22 Gear

There are two kinds of gears in Edison. A spur gear in three different sizes and a bevel gear. These gears can be connected by putting them on axles and moving their stands into appropriate positions. Bevel gears can be meshed with each other at an angle of 90 degrees. They must be placed on the end of axles, and the stands must be 90 degrees to each other.
5.23 Pulley

If one pulley is on a driven axle and a second pulley is moved close enough, a belt will automatically appear and connect the two pulleys.

5.24 Worm Gear

Worm Gears can be meshed with and driven by spur gears.

5.25 Rack-Pin

Rack is a plate with a track of teeth. It can be meshed with the biggest Gear if placed under it.

5.26 Axle

There are two kinds of axles in Edison: a horizontal and a vertical axle. On the horizontal axles you can put at most three gears or pulleys: one in the middle of the axle and two other at both ends of the axle. On the vertical axles you can mount only one gear or worm.
6. THE COMMANDS

This chapter presents Edison’s commands in detail, organized according to the menu titles and menu items.

6.1 File

Use this menu to open and save your circuit files, select experiment and problem sets, print your circuits, and exit from Edison.

6.1.1 New

This command will clear the working area so you can build your own circuit. If the previous circuit has not yet been saved, a warning message appears.

6.1.2 Open

This command lets you load previously saved circuits. The extension of circuit files is .CIR. You can use a dialog box to select the appropriate directory and/or file name.

6.1.3 Save

Use this command to save circuits which have already been named; i.e., have been previously saved or loaded.

6.1.4 Save As

Similar to the Save command, but asks you for a new file name under which to save the circuit.

6.1.5 Export...

With this command, you can export the actual Edison screen to a high resolution Windows bitmap (BMP), Windows metafile (WMF), or JPEG (JPG) image. The exported pictures show only the working area (not the menu bar). This command brings up a standard save dialog box in which you must specify the path and the file name for the picture. Before you enter the file name, you can specify the format you wish to use for export. After completing and accepting the save dialog items, a new dialog appears which contains output specific parameters explained below.

Export picture

This command brings up a standard save dialog box in which you must specify the path and the file name for the picture. Before you enter the file name, you can specify the format you wish to use for export. The exported pictures show only the working area (not the menu bar). The picture parameters like size, jpeg quality etc. can be set in the Options dialog export tab.

By increasing the width or height of the bitmap, the picture resolution increases. If you double the pixel width and height, the picture resolution will also double.

Export VRML model

This command can be used to export the whole 3D model in VRML format. This includes everything what can be seen on the table. The output model can be later opened and seen by a 3D model viewer like Cortona or White Dune VRML97 tool.

6.1.6 Print

With this command, you can print the actual Edison 3D screen. The printed picture shows only the working area (not the menu bar).

In all options, the size of the picture will be exactly the size of Edison on the screen.
6.1.7 Print Setup

You can set printer parameters.

6.1.8 Exit

Exit allows you to end your Edison work session. If you have not yet saved your circuit, a warning will appear.

6.2 Edit

This menu allows you to undo-redo your editing, to cut, copy and paste parts in the circuit, to insert external VRML models or 3D text tables into the 3D view, to modify parameters of the parts, and to repair damaged parts.

6.2.1 Undo

With this command you can undo your last editing action. Clicking on this menu repeatedly will go back in time step by step as you edited your circuit. If there is no previous editing step (you just opened a file or cleared the table with the new command), this menu is disabled.

6.2.2 Redo

With this command you can redo your last undone editing action. Clicking on this menu repeatedly will go forth in time step by step as you edited your circuit. If there is no further editing step (you haven’t undone anything), this menu is disabled.

6.2.3 Quick Mouse

This option lets the 3D editor use wire frame and simplified models while you move the camera. This is useful on older computers with less advanced 3D video card, because it makes editing faster.

6.2.4 Cut

This command copies the selected parts to the clipboard and deletes them from the working area simultaneously.

6.2.5 Copy

This command copies the selected parts to the clipboard.

6.2.6 Paste

This command inserts the content of the clipboard into the 3D view, just like inserting a new part from the componentbar. If there are more parts on the clipboard they will be inserted together while keeping their relative position to each other.

6.2.7 Select All

This command select all part in the circuit

6.2.8 Invert Selection

This command unselects currently selected parts and selects currently unselected parts.

6.2.9 Insert Text

With this command you can insert text tables into the circuit. When you click on this menu a small text editing window appears. Here you can enter a text in the editing area, and set other parameters like table transparency, color, style and arrow. You can also choose a font by pressing the Font button. The created table will be as large as the text requires in it, so if you break the lines it will be higher and narrower or if you increase the size of the font the whole table will become larger.
If you check in the transparent option the table will be slightly transparent so you can see the other elements behind it. Setting the color will change the background to the selected one, and with the style property you can set the orientation of the text box by making it fix vertical, fix horizontal or dynamic, when it is always faced towards the camera. Finally, the arrow property lets you create a text box with a fix arrow pointing out of it. It can be used to annotate parts in the circuit.

6.2.10 Insert Model

This command can be used to insert a new, user defined 3D model into the circuit. When you click on the menu, a standard open dialog will appear, where you can select a VRML model. This model will then be inserted just like a component picked up from the componentbar.

6.2.11 Rotate Left

With this command you can rotate selected elements counterclockwise 90 degrees. All elements turn around their local center.

6.2.12 Rotate Right

With this command you can rotate selected elements clockwise 90 degrees. All elements turn around their local center.

6.2.13 Repair

Use this command to repair faulty parts. After selecting this command, the cursor assumes the shape of a screwdriver that you can use to point to the faulty component. In normal editing and experimenting mode, Edison will remove the error in the part and restore its shape to normal. In problem-solving mode, Edison will applaud you when you find a faulty component and laugh mercilessly at you when you try to repair a good part.

6.2.14 Delete

With this menu you can delete selected parts or wires from the circuit. Note that you can also simply press the Delete key.

6.2.15 Properties

Most Edison parts have one or more parameters that you can modify; e.g., voltage, resistance, or error status. If you set the error status you can simulate several possible part faults. You can modify the parameters of a part by double-clicking on the part in the editor.

Note that in some cases, the program will set the error status automatically while you are experimenting with a circuit. For example, if you overload a bulb it will ‘blow up’ and its error status will be set to faulty. In this case you can use the Repair or Repair All commands to fix the faulty parts. The error status is also used in the problems provided with Edison where you have to find the faulty part.
6.3 Options

Use this menu to open the options dialog where you can set several editing, simulation and other options.

6.3.1 General Page

In this page you can set the main 3D rendering, sound and file management options.

![Options dialog](image)

**3D rendering group**

Here you can set the 3D rendering method of Edison. Wireframe option draws only the wireframe model of the 3D parts, Flat option uses solid models but no textures on it, and Textures option draws everything including the textures on the models.

If smooth shading is set models have a nice, smooth surface but rendering can be slower, so it is recommended to turn this option off on slow computers.

Use control pad option turns the on-screen camera controls on and off.

Orthogonal view option switches between orthogonal and perspective renderings.

**Lights group**

Setting the light style changes the built in lighting of the work table. There are four light style options: No light, Top light, Head light, Top & Head light.

Light color changes the color of the built in light.

**Sounds group**

Here you can disable animation sounds.

**Other group**

If “Notification on model” errors is checked the program will warn the user if he want to insert a badly configured model (where analysis or 3D parameters are not defined etc.)

If “Preserve viewpoint settings on exit” is checked the program will remember the last camera position between two consecutive program runs.

The “Compress circuit files” option lets the program compress .cir files before saving them to HDD.
If “Save/load schematic layout” is not checked the program will not save the 2D schematic into the cir file, so every modification you make on the right side – in the schematic window – will be lost.

With the “Number of recent files on File menu” option you can set how many recent files the program will remember and show in the bottom of the File menu.

6.3.2 Editor Page

In this page you can set several editing options that affects wire drawing or part selection.

Wires group

Once you have connected the elements with a wire, you can still change the path of the wire by grabbing and dragging it somewhere in the middle. As you move an inner point of the wire its neighborhood will also follow the mouse to preserve the smooth curve of the wire. By setting the drag scope to small or large you can control how much of the wire will then be affected.

Dynamic drag scope means the scope of the affected wire will be determined automatically from the mouse movement. Quick and large mouse movements will have a greater affect on the wire.

Smoothness of the wire can be also be set by moving the slider between coarse and fine.

Default wire width and color is the width and color of any new wire you insert into the circuit. Note that when you set the properties of any wire in the circuit it will automatically set the default width and colors, too. So e.g. when you change a wire to red all subsequent wire will then be red.

Other group

Delay before multiple select starts is the time in msec after which the cursor will turn to multiple select mode when you press and hold the right mouse button.

Gears snap distance and Pulley snap distance are the logical units distances used by the editor when you create Electro mechanical circuits with gears and pulley. When two gears/pulleys are closer to each other that the given distance, they will be “connected”, snapped together.

If Show origo when changing viewpoint is set you will see the origo of the 3D view while you are moving the camera. Note that this is always the center of the camera rotation and zoom.

If Quick mouse is set the program will use simplified models while you are changing the viewpoint. This is useful on slower computers where editing is a bit slow.

6.3.3 Workspace Page

Here you can set the size and texture of the worktable and background.
Table group

*Width* and *depth* is the width and depth of the table.

If you click on the *change* button an open dialog will appear where you can select a picture (in bmp or jpg format) to be the texture of the table.

The *clear* button sets the texture back to “none”.

Texture *width* and *height* is the logical size of the texture you put on the table. So if the table is 15 x 10 large and the texture is 5 x 5, the texture will appear 3 x 2 times on the surface of the table.

*Color* is the color of the table. Note that the actual color on the screen always depends on the lighting of the table (on the built-in and additional light sources).

Background group

*Color* is the color of the background.

6.3.4 Simulation Page

Here you can set the basic properties of the simulation.

Simulation group

By setting *Simulation time unit* and *Animation time unit* you can speed up or slow down the animation. If you set the *simulation time unit* to 1 and *animation time unit* to 2, it means that 1 sec simulation will be animated in 2 secs, so the animation will be slower that the real operation of the circuit. *Simulation time unit* is also used in single step transient mode. This is time unit the analysis runs.
**AC/DC timer interval** tells the program how frequently it needs to refresh the screen in AC/DC mode.

If *Show faults* is set, Edison will display faulty components with a different shape. This command serves as a switch: in its on state, you can recognize the faulty component by its shape or color; in its off state, all parts, faulty or not, are displayed with the shape of good parts. Of course, if you are in the problem-solving (trouble-shooting) mode, Edison shows all parts as being good and you can’t change the state of this switch.

If *Show breadboard’s internal connections* is set and you move the mouse above a hole on the breadboard you can see a red rectangle around the holes that are connected to this hole.

The breadboards contain several internal connections. When you place components on the breadboard so that one or more of their terminals are connected within the breadboard, the program will always automatically recognize and make the connections. If *Show breadboard’s circuit connection* is set, Edison not only recognizes the hidden connections, but also displays them by drawing blue lines between the connected pins. These lines stay visible even when the mouse is not near them.

**6.3.5 Export Page**

Here you can set the main parameters of the exported image (File->Export->Export picture menu).

![Image group](image)

*Image group*

*Width* and *height* is the size of the exported picture. Note that the picture will always be proportional, Edison will not stretch the image in any direction even if you set the width and height ratio to a different value that the current screen.

If *Current window size* is set the exported image will be equal in size with the picture seen in the window. This is similar to a screenshot.

Jpeg format *grayscale* option can be used to convert the image to grayscale before saving it into a file. Jpeg format *quality* is the quality of the exported jpeg image. Smaller quality settings results smaller jpeg files.

**6.4 Experiments**

Use this command to see, hear and experiment with the electrical scenarios included in the program. You can define your own experiments, and add them to the experiments menu to easily access them later.
Once an experiment is selected, Edison will load the appropriate circuit and sound file. Then you can follow the on-screen comments, or just start experimenting on your own.

6.4.1 Add/Rename

Use this command to add a new circuit to the experiments menu.

Create a new experiment or load a circuit and add your comments to it. Then select the Experiment.Add/Rename menu to add your circuit to the experiments menu. A small dialogbox appears where you can enter a description about the experiment and set the path to the circuit file.

The new experiment will be added to the end of the menu. Note that if the circuit is already on the list, this menu will only modify its description, it will not add the circuit to the menu twice.

6.4.2 Delete

This command deletes the current circuit from the experiments list.

6.4.3 Autoplay

This command can be used to play all the experiments one by one. Experiments are played in an endless loop until the user clicks with the left mouse button somewhere in the 3D view.

Experiment interval: This is the time interval before the next experiment is loaded.

Wait before switch: After loading an experiment in autoplay mode, Edison waits some time, then turns the switches on or off in the circuit. This is useful for showing how the switch affects the behavior of circuit (a lamp will turn on, a capacitance is charged etc.).

Repeat switch: If this option is set, Edison will turn on and off all switched in the circuit repeatedly.

Wait before camera moves: After this given time the camera will start moving around the circuit to show the circuit from other viewpoints. The camera can revolve or swing around the center of the table. When swing is selected you can also specify the minimum and maximum angles between the two end viewpoints.

6.5 Problems

Use this command to create, edit and solve problems and trouble-shoot circuits provided with the program.
To create or edit problems and problem sets you need to enter a password. The initial password is “Edison5” but you can change it to anything by pressing the Change button in the password dialog.

Note, that the program asks the password only once during a program session, so after you have entered the correct password you can access these menus without limitation.

If you have already opened a problem set, you can choose from several tasks. Generally, you have to find the faulty component or type in the correct value. When you think you have found the faulty component, you can repair it by activating the Repair command. Use the screwdriver to point to the presumably faulty component. If you have found the faulty component, Edison will reward you with applause and you will get the highest score; if you are wrong, you’ll hear a disapproving sound. In this case, you can go on repairing the components one by one, but each wrong attempt will reduce your score. If the program prompts you to type in a value (a value which would be displayed by a meter if there were no fault) and you are right on the first trial, Edison will applaud you and give you the highest score. Edison will play an unpleasant sound if you are wrong.

Although Edison always applauds you when you give the right answer, it reduces your score or sets it to zero after multiple trials.

**6.5.1 Run Problem Set**

Use this command to open and run an already defined problem set. When you select this menu, a standard open dialog appears on the screen where you can select a problem set. After you have clicked the open button, Edison turns into problem solving mode, loads in the problem set and runs the first problem. Also a small panel appears on the right of the component bar, where you can easily select a problem from the problem set and also see your current score. (The same problems can also be selected directly from the problems menu.)

In problem solving mode Edison’s editing features are limited: you cannot insert components other than meters into the circuit, file’s new, open, save and edit’s cut, copy, paste menus are disabled. To return to normal editing mode select the End problem solving from the problems menu.

When you run a problem, Edison asks you a question regarding the circuit. There can be three kinds of questions.

*Multiple choice question* is when you need to find the correct answer from three or more answers.

*Calculate value question* is when you need to calculate the value (voltage, current or impedance) of a meter in the circuit. The display of these meters are disabled in problem solving mode.

*Find the faulty part* is when you need to select the faulty part with the screwdriver in the circuit. To help you in the answer, you may insert additional meters in the circuit to measure currents, voltages etc.

If you are still unsure in the answer, you can get hints from Edison. In the problem dialog select the Hints tab and press the Next button one or more times. Each new hint will decrease the maximum points you may get for the problem, so e.g. if you have read all the hints you will get no point to that problem. You may however at any time turn back and see previous hint without loosing further points.

When you are ready with the answer enter it into the edit box or select the faulty part and press Answer. Edison will automatically evaluate your answer and tell you if it was good or wrong. In case you gave a wrong answer the program will also give you the correct answer.

You may at any time escape from the current problem and select another problem from the problem set (and return to this problem later) by pressing the Cancel button in the problem dialog.

**6.5.2 Create Problem Set**

Use this command to create a new problem set. If you select this menu a standard open dialog appears where you can define the path and name of the problem set.
6.5.3 Open Problem Set

Use this command to open problem set for editing. If you select this menu a standard open dialog appears where you can define the path and name of the problem set. After pressing Open the problem set will be loaded into Edison and the problems defined in it appear in the Problems menu.

6.5.4 Edit Problem Set

Use this command to edit a problem set. If you select this menu the Problem set dialog appears where you can edit the title of the problems, reorder the problems in the list or add and remove problems to and from the problem set.

If you press the View button the selected problem will be loaded into Edison so you can have a quick view of the problem you are editing. If you double click on a problem filename a standard Open dialog will appear where you can select the problem file easily. Note, that the path to the problem is always relative to the folder of the problem set, so in case the problem file is in the same folder as the problem set, you need to specify only the filename.

6.5.5 Define Problem

Use this command to assign a question to the current circuit. When you select this menu the Problem dialog will appear where you can select the question type, specify the question, define the score and add hints to it.
First, you need to enter the question into the Question field and select the type of the question. There can be three kinds of questions:

*Multiple choice question* is when you need to find the correct answer from three or more answers. In this case you need to enter the possible answers into the Answers memo field – each line will be a unique answer – and select the good answer below it.

*Calculate value question* is when you need to calculate the value (voltage, current or impedance) of a meter in the circuit. In this case the Value of one (and only one!) meter in the circuit needs to be set as Aim. This can be set in the Properties dialog of the meter, by double clicking on the component.

*Find the faulty part* is when you need to select the faulty part with the screwdriver in the circuit. In this case, you need to set the Error parameter of a component in the circuit to open, short, or rundown.

Finally, you can assign a Score to the problem and add hints by pressing the Add hint button and entering the hint into hint memo below the score. You may also remove the currently selected hint by pressing Delete hint.

### 6.5.6 Add Problem to Set

This command opens the problem set dialog, and automatically adds the current circuit to the end of the list. You may also assign a title to the problem or reorder the problems in the list.

### 6.5.7 Delete Problem from Set

Use this command to remove the current circuit/problem from the problem set.

---

**6.6 Simulation**

Here you can start and stop the simulation, change the simulation mode between AC/DC, Transient single, and Transient continuous, and edit the simulation options.

---

**6.7 Help**

You can activate Edison’s help system with this command.

#### 6.7.1 Contents

By selecting this menu item, or by pressing F1, you will jump to the help system. Any time you are lost in the program or don’t know how to proceed, just press F1 and you will find detailed information about menus, hotkeys, commands, etc.

#### 6.7.2 Topic search

This leads you to the topic search window of the help system.

#### 6.7.3 How to use help

Edison’s help system is implemented as a standard Windows help system. If you would like to learn about Windows help systems, select this option.

#### 6.7.4 Getting started

This help file contains the ‘Getting started’ section of this material.

#### 6.7.5 About

Use this command to obtain information about DesignSoft, the version number of the program copy you are running, as well as certain other details
7. THE SCHEMATIC ANALYZER

7.1 What is the Schematic Analyzer?

Once you become familiar with schematic diagrams, you can use Edison’s Schematic Analyzer to simulate complicated analog and digital circuits. In addition to the components in the Edison 3D Lab, you can select parts from a catalog based on real analog and digital ICs. You can examine analog circuits using DC, AC, and transient analysis, and digital circuits through step-by-step or complete timing diagram analysis.

Derive transfer functions or time responses, check your homework, or draw poles and zeros with the Schematic Analyzer’s unique symbolic analysis. You can refer to any circuit parameter either by symbolic name or by value on a component by component basis. This helps you not only develop an in-depth understanding of circuit operation, but also saves hours of work deriving or checking formulas.

7.2 Experimenting with Example Circuits

Start the program and click the File menu item in the top line of the screen to roll down the File menu. Now select the Open command and the standard open dialog box appears with *.SCH, indicating that a file name with .SCH extension is requested. Select the EXAMPLES subdirectory, and a list of files with .SCH extensions appears. After selecting one of the files, the circuit schematic will appear.

Now you can execute an analysis, modify or expand the network, and evaluate the results. Keep in mind that every command may be aborted by pressing the [Esc] key or clicking on the Cancel button.

7.3 Schematic Editing Using the Mouse

Here are some basic mouse techniques to help you edit schematics.

Using the right mouse button: If you press the right button of the mouse at any time, a popup menu appears. Using this menu you can:

- **Cancel Mode.** Exit from the last operation (e.g. moving a component, drawing a wire)
- **Last Component.** Return to the last component and reposition it
- **Wire.** Switch to wire drawing mode. In this mode the cursor turns into a pen. Place a wire by holding down the left key of the mouse and dragging the pen.
- **Delete.** Delete selected component(s)
- **Rotate Left, Rotate Right, Mirror.** Rotate or mirror the component currently selected or being moved.
- **Properties.** Use this command to edit the properties (value, label) of the component currently selected or being moved. From the Properties menu, you can set all parameter of a component (while it is still unplaced). This lets you place multiple copies of the component, all with the properties just entered. While you are in the component property editor, the right mouse button has another function. When you are editing the field of any component parameter other than the label field, you can copy that field to the label field by pressing the right mouse button and then selecting the Copy to Label command. You can accomplish the same thing by simply pressing F9.

Using the left mouse button: In the descriptions below, ‘clicking’ always refers to the left mouse button.
- **Selection.** Clicking on an object will select the desired object and de-select all other objects.

- **Multiple selection.** Clicking while holding down the [Shift] key will add the object under the cursor to the group of currently selected objects. If the object under the cursor is already in the currently selected group, clicking will remove it from the group.

- **Block selection.** To select a block of objects all at once, first make sure there is no object under the cursor. Then press and hold down the left button while moving the mouse (dragging). This will create a rectangular block, and all objects within the block will be selected.

- **Selection of all objects.** Press Ctrl+A to select all objects.

- **Moving objects.** A single object can be moved by dragging it (Position the cursor on the object, press and hold the left button, and move the mouse.) Multiple objects can be moved by first selecting them (see above), then clicking the left button while the cursor is over one of the selected objects, holding the left button down, and dragging.

- **Parameter modification.** Double-clicking on an object will bring up its parameter menu so that you can modify its parameters (if it has any).

- **Crossing wires.** The crossing of two wires does not result in a connection at the crossing unless you deliberately choose there to be one. Use Edit.Hide/Reconnect to place or remove a connecting dot. However, it is better drafting practice to never make a connection at a wire crossing, as this avoids ambiguity about the presence or absence of a dot.

- **Block or symbol copying.** After a block or symbol has been selected, you may copy it by pressing Crtl+C. Then click outside the block or symbol to release it, and press Crtl+V. You will see a copy of the block which you can place as you wish. If the schematic window doesn’t show enough room for the copy, press Alt - to zoom out. Once you’ve located the block, click the left mouse button once to anchor it and a second time to deselect the moved block.

### 7.4 Measurement Units

When setting parameters for electronic components or specifying numerical values, you may use standard electronic abbreviations. For example, you can enter 1k (ohm) for 1000 (ohm). The multiplicative factor abbreviations should follow the numeric value, e.g., 2.7k, 3.0M, 1u, etc.

The following characters indicate multiplication factors:

- **p** = pico=10^-12  
- **T** = tera=10^12
- **n** = nano=10^-9  
- **G** = giga=10^9
- **u** = micro=10^-6  
- **M** = mega=10^6
- **m** = milli=10^-3  
- **k** = kilo=10^3

**Note:** Upper and lower cases must be carefully distinguished (e.g., M≠m), and the selected letter must follow the numeric characters without a space (e.g., 1k or 5.1G), or the Schematic Analyzer will indicate an error.
7.5 The Basic Screen Format

After start-up, the following screen appears on your monitor:

The screen consists of these principal elements:

1. **The Menu bar**
2. **The Cursor or pointer.** This is used to select commands and to edit schematics. You can move the cursor only with the mouse.

   Depending on the mode of operation, the cursor assumes one of the following forms:
   - An **arrow**, when a command selection is required in the edit window.
   - A **component symbol (accompanied by an arrow and small box)**, when inserting that component onto the circuit in the schematic window. Until the position of the component on the schematic is chosen, its movement is controlled by the mouse.
   - A **pen**, when defining the endpoint of a wire
   - An **elastic line**, when defining the endpoint of a wire or the second node of an input or output.
   - An **elastic box**, when defining a block after fixing its first corner.
   - A **dashed line box**, when positioning a component label or a text block.
   - A **magnifying glass**, when defining a zoom window
3. **The Schematic window** This shows the circuit schematic currently being edited or analyzed. The schematic window is actually a window onto a larger drawing area. You can move the screen window over the full drawing area using the scroll bars at the right
and bottom of the screen. When selecting the New command on the File menu, the system automatically aligns the origin of the editor window with the center of the entire editor drawing area. The same is true when an existing circuit file is loaded, as this is the default window position.

You can think of the schematic as existing on several “layers.” In addition to the primary layer that holds components, wires, and text, there are two other drawing layers, which you can turn on or off individually. It is generally convenient to have these two layers on.

- **View.Pin Markers On/Off:** Displays/hides component pin ends

A grid of closely spaced dots covering the entire drawing area may be made visible or invisible in the schematic window, depending on the current state of the grid button of the Grid On/Off switch on the View menu. At some schematic zoom levels, you will not see the dots of the grid; nevertheless, all component pins and connecting wires will be on grid. These dots represent the only available interconnecting points. Component symbols are positioned on the drawing area horizontally and vertically. These symbols are rigid patterns with predefined pin positions and are handled as single units. This permits the software to unambiguously recognize the network nodes.

- **View.Grid On/Off:** Displays/hides the grid

(4) **The Tool bar** You can select most of the editor commands (e.g. select, zoom, wire etc. from this tool bar.

(5) **The Component bar** Components are arranged in groups, named by the tabs on the Component bar. Once you have selected a group, the available component symbols appear above the tabs. When you click on the desired component (and release the button), the cursor changes to that component symbol and you can move it anywhere in the drawing area. You can also rotate the component by pressing the + or - keys (on your computer’s numeric keypad) or mirror it by pressing the asterisk (*) key (also on your computer’s numeric keypad). Once you have selected the part’s position and orientation, press the left button of the mouse to lock the symbol in place.

(6) **The Task bar** The Task bar appears at the bottom of the screen and provides speed buttons for the various tools or T&M instruments currently in use. Each tool or instrument operates in its own window and can be made active by clicking on its speed button (icon of the tool). Once the cursor is over the speed button, a brief hint appears. Note that the first button (furthest to the left), the Lock schematic button, has a special function. When the Lock schematic button is pressed, the schematic window is locked in place as a background behind other windows, so that it can never cover a diagram or virtual instruments. When the schematic window is not locked and it is currently selected, you will always see the entire schematic window with any other windows hidden behind.

(7) **The Help line** The Help line, at the bottom of the screen, provides short explanations of items pointed to by the cursor.

### 7.6 Placing the Circuit Components

Components are selected from the Component bar and their symbols are moved by the mouse to the required position. When you click the left mouse button, the program locks the pins of the component symbol to the nearest grid dots.

Components can be positioned vertically or horizontally and rotated by 90-degree steps in a clockwise direction by pressing the [+ ] key, or in a counterclockwise direction with the [− ] key. In
addition, some components (like transistors) can also be mirrored around their vertical axis by using the [*] key on the numeric keypad. You can also use the icons or the popup menu (right mouse button) to position components.

After a component symbol has been selected and positioned, you may double click on it to enable a dialog window where you can enter parameter values and a label. When entering numeric values, abbreviations of integral powers from $10^{-12}$ to $10^{12}$ can be used as indicated in Section 4.1. For example, $1k$ is understood as 1,000.

*Note:* If you do not wish to run the analysis later on in the Tolerance mode, you can ignore the tolerance parameters.

The Schematic Analyzer encourages you to enter a label for each component you place on the schematic. Unless you are working in a great hurry and just want a quick answer or have created an extremely simple circuit, entering labels (of the form R4,10k) is good practice. The first part of the label, R4, is required for any of the symbolic analysis modes other than the semi-symbolic modes. The numeric part of the label, 10k, is only for visual schematic documentation. During symbolic analysis, the Schematic Analyzer will use the numeric value in the value field, not the one in the label.

**Wire:** A wire establishes a simple short (zero ohm connection) between two component pins. To place a wire, select the Insert.Wire command (hotkey: [Space]), move to the beginning point, press and hold the left mouse button, drag the connecting wire to the end point, and then release the mouse button. Wire segments are always vertical or horizontal. Be sure not to leave any component nodes unconnected. When you have completed wiring, use the popup menu (press the right mouse button) or press the Esc key to terminate the wiring mode.

**Input and Output:** Certain types of analysis (DC Transfer characteristic, Bode diagram, Nyquist diagram, Group delay, Transfer function) cannot be executed until both input and output have been selected. These establish where the excitation is applied and where the circuit response is taken. The output(s) chosen also determine which curve(s) will be displayed in the chosen analysis mode. Sources and generators can be configured as inputs, while meters can be configured as outputs. However, meters can also serve to determine the location of the input quantity that will be used when computing AC Transfer curves and functions. For even greater flexibility, inputs or outputs can be established at nearly any location by using the Insert.Input and Insert.Output commands. Note that you can define the input parameter for parameter sweeping only through the Insert.Input command.

To insert an input or output, move the cursor over the icon on the Tool bar, click, release, and drag the input or output to the schematic node that it should define. Then click the mouse button and hold it, while you drag the input or output in the direction of the other node, (usually a ground reference node). When the input or output has been extended to the second node, release the mouse button.

Since an input reference can be established in so many ways, it is important to remember that only one input at a time can be defined within a circuit.

Similarly, in some of the Schematic Analyzer’s analysis methods only one output can be defined within a circuit. These methods include the Symbolic Analysis methods.

7.7 Exercises

7.7.1 Editing a Circuit Schematic

Create the circuit diagram of a series RLC network as shown in the next figure:
Clear the schematic window with the **File.New** command. The file name in the top line is set to *Noname*, indicating that a new circuit file is being edited.

Now start adding components. Select the **Sources** tab (below the component icons): the icons of the available sources will appear. Click on the voltage generator icon then release the mouse button. Your cursor will change into the generator symbol. Position it using the mouse (or pressing the 

\[+\]

or \n
\[-\]

key for rotation or the \n
[*\]

key for mirroring) somewhere in the middle of the screen, then press the right mouse button: the schematic editor’s popup menu will come up. Select **Properties**. The following dialog box will appear:

Leave the **DC level**, **Signal**, and the **IO state** parameters unchanged. Note that by accepting **INPUT** for the **IO state** parameter you have selected the output of this generator to be the input for the Bode diagram.

Select the **Signal** menu line and then press the **...** button, a new dialog box with the graphics icons of available voltage generator signals will appear. When you select one of them (in this case, click on the **Sinusoidal** button), the associated curve comes up with some default parameters. In the case of the **Sine signal**, these are:
Set the Frequency to 150k. Click on OK and return to the previous dialog box. Enter Source as label text and Click on OK. The program will automatically place the label near the component and you will be able to position and place the component and the label together. If the default label position is not satisfactory, you’ll be able to drag the label to the desired position later on. When the component is where you want it, press the left mouse button to drop it. This completes the placement of the generator.

Now click on the Basic tab and choose the Resistor icon (your cursor will automatically change when you are over the tabs or the icons). After the symbol of a resistor has appeared in the schematic window, press the right button of the mouse and then select Properties from the popup menu. The following dialog box appears:

Change the Resistance to 100, then move over the line Label and type in R, 100.

Note: You can copy the resistance value (in this case 100) into the label field by pressing F9 or using the popup menu while you are in the value field.

After setting all parameters, click OK. Your cursor will turn into the resistor with the frame of the label. Position it as required and press the left mouse button to drop it.
Continue circuit entry with the \( L \) and \( C \) components as indicated in the figure above. Set the parameters to \( L=1\,\text{m} \) and \( C=1\,\text{n} \). Enter \( L,1\,\text{m} \) and \( C,1\,\text{n} \) Labels, respectively. Note the default values of the parallel resistive losses for the capacitor and the series resistive losses of the capacitor. Add the Volt Meter (chosen from the Meters component group) in parallel with the capacitor and accept its default IO state: OUTPUT parameter. Place a ground below the generator and connect the generator, capacitor and open circuit as shown in the figure using the Insert.Wire command (hotkey: [Space]). Alternatively you can also use the \( \int \) pen icon or the popup menu to start drawing a wire.

Finally, add the title to the schematic. Click the \( \text{T} \) icon and the text editor will appear. Type in: RLC Circuit. Click on the \( \text{F} \) icon and set size 12. The editor also lets you choose another font, style, color etc. Now click on OK, then position and drop the text on the schematic editor Window.

Before going on, save the circuit with the File.Save As command. Name the circuit as RLC_NEW.SCH (the \( .\text{SCH} \) extension is added automatically).

If you wish, you can still change the circuit in many ways:

- Add new components.
- Delete, copy, or move selected objects using the Edit|Cut, Copy, Paste, and Delete commands.
- Move, rotate, or mirror groups of components. Select the components one by one, holding down the shift key as you click on them. You may also use indow selection to identify the group. When you’ve selected the last component, release the left mouse button. Then move the cursor over one of the selected components, press and hold down the left mouse button, and drag the selected parts with the mouse. While dragging, you can use the [+] and [-] keys to rotate and mirror components.
- Move any component label separately by clicking on it and dragging
- Modify component parameter value(s) and labels of the component by double-clicking on it.

Of course, if you want to keep these changes you must save the circuit again.

7.7.2 Running an Analysis

The Schematic Analyzer has a variety of analysis modes and options.

The analysis method is analog when a circuit contains only analog components; then the components are modeled with their analog models.

The analysis method is mixed when a circuit contains both analog and digital components; then the components are modeled with their analog models.

The analysis method is digital mode when a circuit contains only digital components; then the components are modeled with their fast digital models.

Now execute AC and transient analyses on the RLC circuit you have just entered.
First perform an AC nodal analysis. Select **Analysis.AC analysis.Calculate nodal voltages**. Now your cursor will turn into a test probe which you can connect to any node. In a separate window the nodal voltages will be displayed. If you have placed any meters on the schematic, clicking on them with the probe will present detailed information from that instrument. Note that you can acquire DC nodal voltages in a similar fashion through DC Analysis.

Now select **AC Analysis.AC Transfer Characteristic**... from the main menu. The following dialog box appears:

By default Amplitude&Phase will be calculated. Select Amplitude and Nyquist in addition. Modify the Start frequency to 10 k and then press OK. A progress bar will appear while the program is calculating. After the calculations are finished, the Bode amplitude characteristic will appear in the Diagram Window. You can easily switch to Nyquist or Amplitude&Phase diagrams by using the Tabs at the bottom of the Diagram Window.

You can read exact input/output values by enabling one or more of the cursors. Note that in any representation you can get and place the formula of the transfer function using Symbolic Analysis and selecting AC Transfer or Semi Symbolic AC Transfer. The formula will appear in the Equation Editor Window and you can place it either on the Diagram or the Schematic window as described above.

Using the Schematic Analyzer’s graphic facilities, you can add more useful information to your diagram. As an example, let’s add markers, a special annotation, and the circuit schematic itself to the diagram.
To add markers to a curve move the cursor over the curve, find a position when the cursor changes into a + shape and click on the curve at this position. When the curve becomes selected, it turns red. Now you can either doubleclick on it or press the right button of the mouse and select Properties on the popup menu. A dialog box will appear and you can set the curve’s parameters: Color, Line width, Marker. Select Marker Type: Square and click on OK.

To add some text, click on the text icon. When the Text editor appears, type in “Resonance.” Note that using the font icon of the editor you can select any font, style, size and color. Click on OK and place the text in the neighborhood of the resonance peak. Now click on the pointer icon, then on the text, and finally on the peak of the curve. Note the your cursor will turn into a + when you are at the right position. You have just entered a line and arrow that will always point from the text to the curve, even if you drag the text into another position or make other changes.

Now place the schematic itself on your diagram. Click the schematic editor Window and select Edit.Select All. Copy this selection into the clipboard by selecting Edit.Copy or clicking on the Copy icon or using the Ctrl C hotkey. Click on the Diagram Window and use Edit.Paste, or click on the Paste icon, or use the Ctrl V hotkey. The frame of the circuit diagram will appear. Position and drop it at the left corner of your diagram. Now you can still modify this picture by dragging or doubleclicking on it and changing its size, frame or background.

Now perform a transient analysis. First, make sure your cursor is the selection arrow, then doubleclick on the voltage generator (and change the waveform to the default unit step . After selecting Analysis.Transient Analysis, the following dialog box appears:
Change the **End display** parameter (1.0 u) to 30 u then press **OK**. In a separate window the transient response will appear:

![Transient Analysis Window](image)

As expected, the RLC circuit exhibits a response of damped oscillation. Exact input/output data pairs can be read by enabling the **a** and/or **b** graphic cursors.

Now select **Analysis.Symbolic** or **Analysis.Semi-symbolic Transient** from the menu. The closed form expression of the circuit response appears in the Equation Editor window. Click on the Copy icon of the Equation Editor Window, then switch to the Schematic window and select the Paste icon. The frame of the formula will appear. Move the frame to the desired location and press the left mouse button to place the formula. Note that you can reposition it by dragging to any position and you can edit it by double-clicking on it.

### 7.7.3 Analyzing a Digital Circuit

Let’s test a digital circuit. Open the file EXAMPLES\HALF_ADD.SCH. Start the **Analysis.Digital Step-by-Step** command. A control panel will appear and you can examine the behavior of the circuit step-by-step by pressing the Step Forward button. Press the Play button for free-running mode. At each node a small box will indicate the logic level (Red for High, Blue for Low, Green for High Z, Black for undefined) as the circuit is clocked.
The picture below shows an intermediate state of the display.

Now let’s examine the transient behavior of the circuit. Selecting the *Analysis.Digital Timing Analysis* command, brings up this menu:

The result is shown on the timing diagram below.
You could also select **Transient...** instead of **Digital Timing Analysis**, in which case the program would carry out an analog analysis, giving the detailed continuous waveforms and voltages instead of idealized logic levels. Note that circuits which contain only digital components can be analyzed by both digital and analog methods. Circuits containing both analog and digital components, on the other hand, can only be analyzed by the analog method. Next, load the file \EXAMPLES\HALFADMX.SCH. Because this circuit has two passive parts (a resistor and a capacitor), The Schematic Analyzer must use analog (or mixed-mode) Transient analysis.

The result is the time response below.
Notes:

- You can set the order of the curves by simply appending a colon (:) character and a number to the output name. This is particularly important when presenting the results of digital analysis, where each output is displayed as a separate diagram. For example, if you have outputs named OutA, OutB, Carry, and Sum, you can ensure that they will be displayed in the order given by using the labels OutA:1, OutB:2, Carry:3, and Sum:4.

- The results of a purely analog analysis normally appear in one diagram; however, you can force the Schematic Analyzer to display the results as separate diagrams, in the order you desire, by using the labeling method described above. You must use the View | Separate Curves command in the Diagrams window to separate the curves. If you don’t use this labeling method, the Schematic Analyzer presents the curves in alphabetical order.

7.7.4 Testing your circuit in interactive mode

When everything is in order, the ultimate test of your circuit is to try it in a “real life” situation using its interactive controls (such as keypads and switches) and watching its displays or other indicators. You can carry out such a test using the Schematic Analyzer’s interactive mode. Not only can you play with the controls, but you can also change component values and even add or delete components while the analysis is in progress. You can activate the interactive mode with the and buttons located on the right side of the toolbar. First, select the interactive mode required (DC, AC, Transient or Digital) with the button, then press the button. Now the displays and indicators in your schematic will reflect whatever you do with the controls. In addition to displays, the Schematic Analyzer has special multimedia components (light bulb, motor, LED, switch, etc.) which respond with light, motion and sound.

To try out the interactive mode, load the DISPKEY.SCH circuit from the EXAMPLES\ folder. The circuit is shown below. Select the Digital mode using the button, and then press the button (the button will turn red). Now you can play with the keypad and watch as the 7 segment display shows the setting of the keypad. If you have a soundcard on your PC, you will even hear the key clicks of the pad. You can find further multimedia examples in the EXAMPLES directory.
7.7.5 Microcontroller circuits

To test circuits with programmable devices requires special development software that permits a high degree of interactivity. This calls for debugging software that can test the code running in the device step-by-step. TINA v8 and higher versions support PIC microcontrollers; support for other MCUs are constantly being added to TINA. Even though you can add your own microcontrollers described by VHDL, the built in microcontrollers in TINA are precompiled for higher performance. Their VHDL code is not visible to the user.

In any event, you can see, modify, and debug the program running in any of the supported processors, and, of course, you can make and run your own code.

There are two ways of providing the program for microcontrollers in TINA. You can use the binary code and debug file made by any standard compiler (e.g., MPLAB for PICs), or you can just load your assembly code to run and debug directly in TINA using its built in assembler-debugger.

To load the code into the MCU, double-click on the schematic symbol.

One of the following dialogs will appear:

Click on the last MCU File name line and press the to proceed.

The following dialog will appear:

Here you can see and edit the ASM code in the MCU, select another ASM code file, or create a New ASM directly in the editor that will appear when you press the New ASM button.

If, however, you switch to the Use HEX/Lst file option, you can select the binary (HEX) file you want to run and the LST file to be used for debugging, as shown in the dialog below.
Note: The HEX and LST files should be generated by an appropriate compiler (normally provided free by the MCU manufacturer. However, TINA has a built in compiler for all supported MCUs, so you can directly use your ASM source code.

7.7.5.1 Example PIC Flasher

Now let us run a microcontroller application and see how to modify its code. Load the PIC Flasher.TSC circuit form the Examples\Microcontrollers\PIC folder. The following schematic will appear with the 16F73 PIC microcontroller.

This circuit is simply counting forward one count at a time. Press the button to see how it works. The display should step forward one-by one.
Now let's release the button and modify the code to count by 2.

Double-click the MCU, and click on the button in the dialog below -

Press the Edit ASM button. The ASM code of the MCU will appear in the MCU Source code editor.
Now let’s make the following change in the code. Change the instruction (selected above) in line 25 (you can see the line number in the right bottom corner of the code editor window) from

```
addlw 01H
```

to

```
addlw 02H
```

Save the changed code by pressing the icon and close the open MCU windows. If you press the button, now the increment will be 2!

Note that the changed code will be automatically saved in the TINA.TSC file.

### 7.7.5.2 Example PIC Interrupt handling

Now let’s see another application with some more interactivity. Load the PIC16F84_interrupt_rb4_rb7.TSC example from the Examples\Microcontrollers\PIC folder.

Press the button. At first glance, it appears that nothing is happening.

However, if you click on the SW-HL1 switch, the display will step forward by 1 each time that the switch changes from Low to High. This is realized with the interrupt handling capability of the PIC16F84.

Now let’s see the operation in more detail using the interactive ASM debugger.

To activate the debugger, select Option on the Analysis menu. Set the “Enable MCU Code debugger checkbox,” as shown below in the Analysis Options dialog box.
The MCU debugger will appear if you press the button:

Here is a short description of the MCU debugger dialog.

On the top line there are the following controlling icons:

- **Toggle breakpoint:** Inserts or removes breakpoints in the selected line. Click on the line where you want to place or remove the breakpoint before clicking on the icon.

- **Run the code in the debugger continuously.** The lines being executed will be highlighted and the code is scrolled.

- **Step forward.** Step by step execution. Each time you press this button one command of the program is executed.

- **Stop.** Halts program execution.

The Code window (below the control icons) displays the ASM code.

The next actual command is highlighted with blue.

The actual content of the registers and memory locations of the MCU are shown in the lower part of the screen.
Let's follow the program execution step-by-step by pressing the Step forward button. After around 14 clicks, we get to the PT1: label, where the program seems to be in an infinite loop.

PT1: INCF TEMP, F
GOTO PT1

Now click on the SW-HL1 switch and change it to High. (You should click when the cursor changes into an upward pointing arrow ). Return to the Debugger and click the Step forward button twice. The program will recognize the interrupt and jump into the INT_SERV: label.

INT_SERV:
INCF COUNTER, F
MOVF COUNTER, 0
MOVWF PORTA

increment the COUNTER, and copy it to PORT A. The output will now be 1. After this, the program will return to the “infinite loop” at PT1.

7.7.5.3 Editing the Code in the Debugger

Now let’s see how to make a small change in the program using the debugger. Duplicate the INCF COUNTER, F statement using Copy and Paste like so:

INT_SERV:
INCF COUNTER, F
INCF COUNTER, F
MOVF COUNTER, 0
MOVWF PORTA

Now if you press the Step forward button, the program will ask:
Press Yes and then press the button again. Now the increment will be 2 at each Low-High change of the switch.

You can also check the circuit in the Debugger’s continuous Running mode by pressing the button. Even though the debugger will run fast, you can still see the “infinite cycle” and the jump to the Interrupt server routine (INT_SERV:) when you change the switch.

### 7.7.5.4 Making a Breakpoint

It is often essentially impossible to get to a certain place in the program since you’d have to single step a thousand times (if the program ever steps there in the first place). To get the program to run to a particular statement and halt there, you can tag the statement as a so called breakpoint. Now run the program in the Debugger’s continuous mode using the Run command and the program will stop at the marked space before execution of the marked command.

To demonstrate this, click on the increment statement in our interrupt.

Service routine after the INT_SERV: label and press the Toggle break button.

Now press the Run button. The program starts to run and falls into the “infinite loop.” Even though you have set a breakpoint, the code will not stop since it does not pass the breakpoint. However, when you change the switch from Low to High the program will stop at the statement. Now you can resume execution either step by step or with the Run command again.